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Content Publisher
Introduction

Here are a few pointers to help you complete the lessons in this Tutorial:

! The Tutorial is available directly from the Startup Screen and the Help menu.

! If you haven’t completed the “Seven Easy Lessons,” you might want to do so before 
tackling the Tutorial. (The “Seven Easy Lessons” are also available from the Startup 
Screen and the Help menu.)

! When you first use the Edit Template dialog box, check to be sure that Auto is selected 
under Preview Update. With Auto selected, Site Builder will automatically update the 
Preview window each time you make changes to the template and return to the Edit 
Template dialog box. This will take a few seconds each time (longer, when you first enter 
the dialog box, as Site Builder loads the browser controls). If you prefer, you can clear the 
check box and click the Preview Update button each time you want to review your 
changes.

! The project files you’ll use throughout the Tutorial are to be found in the ..\Stellent 
Content Publisher\Samples\en folder. The source documents referenced in these project 
files are the styled documents in ..\Stellent Content Publisher\Samples\en\Styled and the 
manually formatted documents in ..\Stellent Content Publisher\Samples\en\Formatted. If 
you can, open the styled documents in Word, print them, and mark them up to denote 
each of the styles used in each document. This may facilitate your understanding of 
templates and elements as you format the source documents in Site Builder and turn them 
into Web pages. Any source document listed in the Contents pane as part of a Content 
Publisher project can be opened in its native format from there. Right-click the document 
in question and choose View Source Document from the popup menu that appears. The 
source document will open in its native format, assuming you have the appropriate 
application available from your machine. 

! If you want to save your work as you go through the lessons, be sure to save the project 
file at the end of each lesson. And if you know that you might want to rerun the lesson 
later, at the start of each lesson you should save the project file under a different name or 
in another location, so that you can always return to the original project file at any time. 

! A special output directory has been designated for most projects (some lessons don’t 
involve translation). You can check this for any publication by right-clicking a 
publication in the Publication Hierarchy pane and selecting Properties from the popup 
menu to open the Publication Properties dialog box. As you complete your first 
translation in each lesson, the appropriate folder will be created by Site Builder to 
accommodate the output pages you create. So at the end of the Tutorial, you will have 
folders for most lessons (..\Stellent Content Publisher\Output\Lesson 1, etc.). Once you 
have completed the Tutorial, you can reopen any of the project files at any time to 
experiment with the templates for the Web publications you have created. 

! If you installed to a directory other than the default, warning messages will appear as you 
load the various project files for these lessons. Site Builder simply wants to know where 
the source files are. You should Browse to identify their new location.

! Remember: When you click OK to leave a property sheet, tab dialog, or dialog box, you 
haven’t actually saved your changes to the template until you have returned to the Site 
Builder main window. Moreover, you haven’t saved the template itself until you formally 
save the project file by clicking Save on the toolbar (or choosing Save from the File 
menu).
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! For the purpose of these lessons, special output directories have been designated for many 
of the projects. For any new projects you create, however, Site Builder will use the 
default output directory:

C:\Documents and Settings\<username>\My Documents\Stellent\Output

Note: You can check the output directory in the Properties dialog box for the root 
publication. 

Throughout the lessons, the instruction to open your browser and view Web pages is given as View. 
This is a short-form reference for the Launch Default Viewer command, which is available from 
both the standard toolbar and the large toolbar. 
6
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LESSON 1

Creating a Frameset

Whether your Web publication has a large number of Web pages or just a few, you need to 
organize the contents of the publication to help your readers quickly find the information they 
need. A frameset can help structure content, while a reference page can improve the 
accessibility of that content.

A frameset is simply a collection of frames that fill the browser window. One frame is used for 
all body documents; the other frames can contain reference pages, URL links, and graphics. 
Site Builder lets you create five different types of reference page: a publication Table of 
Contents (TOC), a List of Figures (LOF), a List of Tables (LOT), an Index, and a Query. Each 
reference page is a separate HTML file, which Site Builder builds during translation.

In the “Seven Easy Lessons,” you promoted headings from a source document to create the 
type of TOC you would expect to find at the beginning of a book. In Site Builder, reference 
pages are quite versatile. With the exception of the Index and the Query, you can promote any 
element in any source document to any of the other three reference pages. The source 
documents don’t even have to share the same template, as reference pages will accept elements 
from more than one template. 

In this lesson, you will 

! Create a frameset for your publication

! Add a reference page to the publication

! Promote elements from the source documents

! Include the elements in the reference page

! Turn off links to the Web pages for the source documents

! Format the reference page

Create a frameset

 1.  Open Promote.tcp from the ..\Stellent Content Publisher\Samples\en subdirectory.

To adjust the two panes, place your cursor on the divider and move it to the left or right. 
Likewise, to expand or contract any column in the Contents pane, place your cursor on 
the dividers between the column headings. 

The publication name appears in the Publication Hierarchy pane and above the Contents 
pane. In this case, it also happens to be the name of the lesson. As you can see, you can 
create descriptive publication names while keeping the project file name (which displays 
in the title bar) simple. The red crosses in the Status column confirm that you have not yet 
translated the source documents. 

 2.  Click Layout on the toolbar ( ) to open the Layout dialog box. 

 3.  Under Active Layout, select Frame Layout to open Frameset Layout.

 4.  Click the New Vertical button. You have created a frameset consisting of two vertical 
frames. You can resize the frames, but for this lesson we will accept the defaults.

 5.  Place your cursor in the Components box at the bottom-left (note how it changes from a 
pointer to a hand), and drag the TOC icon from that box and drop it into the frame named 
trFrame1 (see Figure 1-1). 
7
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 6.  Click OK to accept the frameset for your publication and return to the main window.

Figure 1-1  A simple frameset with the TOC placed in trFrame1 and body documents assigned 
to trFrame2.

You have created a simple frameset that sets the structure for your Web publication. By default, 
Site Builder automatically assigns body documents to one of the frames of a frameset (in this 
case, to trFrame2). However, for the TOC (in trFrame1) to display in your browser, you must 
formally add the TOC to your publication in the Contents pane.

Add a reference page to the publication

Rather than build a typical TOC, you are going to create an abstract, which is simply a 
summary of the contents of different source documents. This is possible because each source 
document used for this lesson contains a paragraph that summarizes the document’s content. In 
addition, a unique element has been associated with this paragraph. 

 1.  Click Add Reference Page on the toolbar ( ) to open the Add Reference Page dialog 
box (see Figure 1-2).

 2.  Under Type, accept the default Table of Contents (TOC).

 3.  In the Name text box, type Abstract.

 4.  Click the New button to open the New Template dialog box.

 5.  In the Name text box, type Abstract.
8
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Figure 1-2  Here, we’re naming both the new reference page and its template “Abstract.”

 6.  From the Based On list, select Business TOC, a reference page template. Note that in 
creating a new template, you can turn on cascading style sheets (CSS). We’ll talk more 
about CSS in Lesson 2.

 7.  Under Template Type, make sure that Reference is selected.

 8.  Click OK to return to the Add Reference Page dialog box.

The Use this reference page template drop-down box now lists Abstract, which is an 
exact copy of the Business TOC template (Figure 1-2). 

 9.  Click OK. The Contents pane now displays an output page named Abstract and also a 
template of the same name. 

The next step is to identify the content you want to go into the reference page. To do this, you 
promote the appropriate elements in the body page template of the source documents. In this 
lesson, you will promote the content associated with the elements Intro and Title.

Promote elements from the source documents

 1.  In the Contents pane, select any of the source documents and click Element Setup  
on the toolbar. Since you are editing the template, not the source document, and the same 
template is associated with all the source documents in this publication, it doesn’t matter 
which document you select.

In Site Builder, two elements are promoted by default in any body page template: 
Heading 1 and Title (System). But for this project file — as you can see from the 
elements list in the Elements tab dialog (Figure 1-3) — only Heading 1 is being promoted 
(the element name appears in the Promote As column).

 2.  In the Elements tab dialog, select the Intro element and click Properties.
9
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Figure 1-3  Heading 1 is the only element currently being promoted.

 3.  Click Promote to open that tab dialog (see Figure 1-4).

 4.  Click Promote this element, making it available to all reference pages. Accept the 
default name Intro in the Promote As text box.

 5.  Click OK to return to the Elements tab dialog. The element name is now listed in the 
Promote As column. 

An element is promoted under its own name, unless you change it. This typically isn’t a 
problem because promoted elements can be formatted differently for the reference page 
template. But you might want to use a different name if you are promoting different elements 
from different templates and want to format all the elements the same way in the reference 
page template.
10
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Figure 1-4  The Promote tab dialog in Element Properties.

 6.  Now select the Title element, but this time double-click in the Promote As column. 
“Title” will appear in the column. You can use this method of promoting elements if you 
don’t want to change the name.

 7.  Double-click Heading 1 in the Promote As column to turn off promotion for that element.

 8.  Click OK to return to the main window.

You have promoted two elements and are ready for the next step. Since any promoted element 
becomes available to any of the three reference pages (TOC, LOF, and LOT), you must now 
formally include Intro and Title in the body of the Abstract reference page (TOC). You do this 
by editing the reference page template.

Include elements in the reference page

 1.  In the Contents pane, select Abstract and click Element Setup on the toolbar ( ).

 2.  Select Intro and double-click the first red cross, in the In Body column, to turn it into a 
green check mark.

You have placed this element in the body of the reference page, which means that the 
content associated with the Intro element will appear in the Web pages created from the 
source documents. You don’t have to do this for Title, because Title is one of three 
elements included by default in a TOC (the reference page type you chose for the 
Abstract). The other two are Heading 1 and Title (System), which we don’t want to 
include. 
11
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Figure 1-5  Element Setup, showing the settings for the Abstract reference page when you first 
enter the Elements tab dialog.

The three “System” elements are explained later in the Tutorial. Briefly, Title (System) is 
the element used to create a title for your Web publication. Even though Title (System) 
wasn’t promoted from the source documents, each reference page template has its own 
title. So the element name was also listed when you entered Element Setup with the 
reference page template selected. 

 3.  Select Heading 1 and double-click the green check mark in the In Body column to turn it 
into a red cross. Do the same for Title (System).

You have added Intro to the Abstract, to join Title, and you have removed Heading 1 and Title 
(System). 

When an element is included in a reference page, Site Builder automatically generates a link 
from the reference page to that element in the Web page (the translated source document). In 
this case, you do not need to link the whole introductory paragraph to the Web pages that you’ll 
create from the four source documents. The title will suffice. 

Turn off links from the Abstract to the Web pages

 1.  With the Elements tab dialog still open, select Intro and click Properties.

 2.  Click Links to switch to that tab dialog.

This tab dialog is available only when you are editing a reference page template. 

 3.  From the Link Type drop-down list, select No Link, and click OK.

 4.  Click OK to return the main window.

The content in the Abstract that is associated with the Intro element is no longer linked to 
the Web pages created from the source documents. But Title still is.

 5.  Click Save on the toolbar ( ) to save the project file and its templates.

 6.  Click Translate on the toolbar ( ) to translate the publication.
12
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Note that when the translation is completed, the red crosses in the Status column turn to 
green check marks.

 7.  In the Contents pane, click View on the standard toolbar ( ). Your Web browser will 
open to display your Web publication. Since your publication has a frameset, it doesn’t 
matter what you select in the Contents pane; the frameset will always open. (See 
Figure 1-6.)

Figure 1-6  Your translated project in Internet Explorer. You can use the Title headings in the 
TOC to jump from one source document to another. If you use the navigation buttons to page 
through the Web publication, note how the publication has been broken up into smaller Web 
pages. By default, a publication splits on Heading 1.

Your Web browser will open to display your Web publication. Instead of the TOC you created 
in “Seven Easy Lessons,” you will see the title for each page and a short description (abstract) 
of each page’s content. Pass your cursor over the text and you will see that the titles (associated 
with the Title element) are linked, but the Intro text isn’t. (You may have noticed that the 
Abstract doesn’t have an overall title. That’s because you removed Title (System) from the 
body of the reference page. Adding titles to Web pages is addressed in Lesson 8.)

You can format the element of a reference page just as any other element. As the Abstract isn’t 
a standard TOC, a few changes will improve its appearance. Remember: the template you are 
using is one of the reference page templates designed specifically for a TOC. So some 
assumptions have been made.

For example, templates for TOCs include the automatic indentation of heading levels (the 
lower the heading level, the greater the indent). That’s something to watch for with most TOCs. 
But Title isn’t one of the elements usually indented, so it isn’t an issue here. However, there is 
some formatting you might do. 

Format the Abstract

 1.  In the Contents pane, select Abstract and click Edit Template on the toolbar ( ).

 2.  Pass your cursor over the Preview window and notice how a tooltip highlights each 
element of the template. That’s one of the advantages 
of using the Edit Template dialog box when editing your templates.

 3.  Click the Formatting button to open that property sheet. From the Elements List, select 
Title. On the Character tab dialog, under Font Color, click the Color button to open the 
Color dialog box. Then select 
a color and click OK. 
13



Content Publisher
 4.  Under Text Effects, click the Effects button to open the Effects dialog box. From the Bold 
drop-down list, select Always On; and from the All Caps drop-down list, select Always 
On. Click OK to return to the Character tab dialog.

 5.  Click OK again to return to the Edit Template dialog box. View your changes in the 
Preview window. Note how content associated with the Title elements is now bold and set 
to “all cap,” and that the color is the one you selected in the Color dialog box.

 6.  Click OK to return to the main window.

Be careful about changing the colors of elements in reference pages. In most instances the text 
in question represents a link to content in the body pages, and you may want to treat links in a 
standard way. See Tip 5. 

 1.  Click Save on the toolbar ( ) to save the project file and its templates.

 2.  Click Translate on the large toolbar ( ) to translate the publication.

Note that when the translation is completed, the red crosses in the Status column turn to 
green check marks.

 3.  Switch to your browser and click Refresh or Reload. If you closed your browser, click 

View on the standard toolbar ( ). Note how the Title element has changed, just as you 
saw it in the temporary translation in the Edit Template dialog box.

Keep the project open. You will need it for Lesson 2.

Tips

 1.  Framesets are a powerful tool for helping you structure and organize the contents of your 
Web publications. As you will discover in a later lesson, you can use a different frameset 
for each publication in your project. 

 2.  Reference pages are very flexible, since you can promote any element to a TOC, LOF, or 
LOT reference page. You can even promote graphics and create thumbnails for a 
reference page.

 3.  An Index is slightly different. To create an index, you must already have index markers 
placed in the source document. Site Builder will pick up the index markers and use them 
to create an Index. If you try to create an Index with a document that doesn’t have index 
markers, you will get nothing.

 4.  A default setting in the Business template is to split the output on Heading 1. (You can 
check this by selecting one of the source documents in the Contents pane and opening 
Element Setup again. In the Split column on the Elements tab dialog, note the green 
check mark opposite Heading 1.) As a result, Site Builder breaks a source document into 
multiple output pages, each one beginning with Heading 1. You can check this in your 
browser by clicking the navigation buttons at the top of each page.

 5.  The colors of linked content in a reference page can be set in the Colors tab dialog in 
Globals. Whatever default colors you set there for Link, Visited Link, and Active Link 
will be used for all elements in the reference page that are linked to the body content. If a 
color for a link isn’t specified there, Site Builder uses default colors, which are bright 
blue for links and purple for visited links. 
14
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LESSON 2

Formatting Text With CSS

Site Builder contains a number of tools for fine-tuning the layout and look of text in your Web 
publications. One of the more important of these is Cascading Style Sheets (CSS), which Site 
Builder implements by means of embedded, inline styles. 

You can take a simplified approach to formatting text in your Web publications by ensuring 
that the setting for CSS is turned off. This setting can be found in the Options tab dialog of 
Globals (see Figure 2-1). It is turned off by default, but it is automatically turned on for certain 
templates in the default project file (those with “CSS” in their name), which you can use in any 
project.

Figure 2-1  The Allow CSS Character and Paragraph Formatting setting in the Options tab 
dialog of Globals is turned off by default. It is turned on for those templates in the default 
project file with “CSS” in their name.

With CSS turned off, you still have many formatting options in Site Builder. But if you select 
this check box, you will find additional options and settings available in the Character and 
(especially) Paragraph tab dialogs of Formatting that can significantly improve your ability to 
fine-tune the appearance of text onscreen. (CSS can also be applied to page and element text 
bars, in Navigation.)

The CSS option is template-based. When you use this switch, it applies only to the template 
selected in the Contents pane when you open Globals. So if your project contains several 
templates, you may want to select this option for each one (including the reference page 
templates), assuming you want to take full advantage of CSS throughout your publication.

In this lesson, you will continue to work with the project file you used in Lesson 1. Open the 
project file now if you closed it after completing Lesson 1. (If you closed it, you will see it 
listed at the bottom of the File menu and also as The Last Publication Used on the Startup 
Screen.) 

Before starting the lesson — and to appreciate the power of CSS — you may want to spend a 
little time in the Character and Paragraph tab dialogs of Formatting, first with the switch on, 
then with it off. With the switch on, the Character tab dialog shows one change: the opportunity 
to select a specific font size. There are many more changes in the Paragraph tab dialog, most of 
which will become readily apparent. 

In this lesson, you will 

! Change the publication name, save the project file under a new name, and change the 
output directory 

! Turn on the CSS option in Globals

! Format the TOC, using additional formatting options available

! Format the body pages, likewise using CSS options

Change the publication name…

If you want to save your completed project file for Lesson 1, you need to rename the file for 
use in this lesson. At the same time, you should also change the publication name.
15
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 1.  Open Promote.tcp if it isn’t already opened.

 2.  Click Save As on the File menu and save the project file under the name Format.tcp in 
the same folder as Promote.tcp. 

 3.  Right-click the publication Creating a frameset in the Publication Hierarchy and choose 
Properties from the popup menu.

 4.  In the Publication Properties dialog, select “Creating a frameset” in the Publication Name 
text box and Publication Title text box, in turn, and type Formatting text with CSS. 
Under Output Directories, change the paths for both Pages and Graphics to 
..\Output\Lesson 2.

 5.  Click OK.

 6.  From the File menu, choose Save.

You have now saved the project file under a new name, changed the title and name of the root 
publication, and created a new output directory (so that your translated output for this lesson 
won’t overwrite your translated output for Lesson 1).

Turn on CSS

Before turning on CSS, click View on the toolbar ( ) to view the Web publication you 
created in Lesson 1. You will get a warning message to translate the project first. By saving the 
project under a new name, you created a new history file that contains no record of a previous 
translation. So first, let’s translate.

 1.  Click Translate on the toolbar ( ). Now click View ( ) again.

 2.  In the Contents pane, select Abstract and click Edit Template on the toolbar ( ).

The Preview window immediately displays the TOC. Pass your cursor over the window 
and you’ll see tooltips — popup text that identifies each element name. This makes it 
easy to edit elements and track your changes as you make them. The Edit Template dialog 
box also offers the advantage of allowing you to move easily between the four property 
sheets (Element Setup, etc.). 

As you’ll remember from Lesson 1, Title and Intro are the two elements we’re working 
with here. Note, in particular, how Title — “Page Navigation” is the first one in the TOC 
— displays onscreen. 

 3.  Click Globals ( ) and then Options to open that tab dialog.

Incidentally, this tab dialog contains additional options when you are editing a body page 
template.

 4.  Select the Allow CSS character and paragraph formatting check box.

 5.  Click OK to return to the Edit Template dialog box, and then OK again to return to the 
main window.

 6.  Select one of the source documents (and thus the second template in the publication) and 
once again turn on CSS in Globals.

Format the TOC

 1.  Select Abstract in the Contents pane and click Edit Template on the toolbar ( ).

 2.  Click the Formatting button to open that tab dialog. The Character tab dialog is open by 
default. From the Elements list, select Title.
16
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 3.  Under Font Name, choose the font you want to use from the drop-down list. Remember: 
the fonts you see here are the ones on your system. If you choose a font not available on 
the user’s system, the browser will substitute another. For our purposes, select a strong 
font, such as Arial Black, if you have it. (But if you do, you might want to return to the 
Effects dialog box and change the Bold setting to From source.)

 4.  Under Font Size, click Use this size. Now check the options available from the drop-
down list. There are more options here when CSS is turned on.

The first seven relate to the standard HTML heading tags (including H1 through H6). 
Since these sizes are set by your browser, you can’t control them. The Larger and Smaller 
choices simply let you choose a new size relative to the existing font size. Custom 
provides the most flexibility. With custom you can specify the exact size you want to use 
in points, inches or centimeters. You can also pick the Percent option to resize the font as 
a percentage of its existing size.

 5.  From the drop-down list, choose Custom. In the first box below, select the default 10.00 
point size and type 12. (The default unit of measure — the second drop-down box — is 
points.) 

 6.  Under Font Color, click the Color button to open the Color dialog box and select red. 
Then click OK.

 7.  Now select Intro from the Elements list.

At this stage, you haven’t saved changes you’ve made for Title. But you’ll be fine as long 
as you click OK when you’re finally done formatting all the elements.

 8.  Select Arial (which is compatible with Arial Black), and set this font to 8 points. (You 
can get away with setting a sans serif font like Arial to 8 points, but for some other fonts 
this size might be too small.)

 9.  Switch to the Paragraph tab dialog, and under Indentation for the Left Side, select Set to 
and accept the default setting of 12 points.

 10.  Click OK to return to the Edit Template dialog box to preview your changes. 

 11.  Click OK to go back to main window, and then click Translate and View.
(See Figure 2-2.)

Figure 2-2  Your Web publication with a few changes made to the TOC with CSS turned on.
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Format the Body Pages

One of the tricks to creating a good Web publication is to be consistent in the styling of all the 
frames in a frameset. Site Builder encourages this, for example, by associating the same 
graphics Set with related templates (thus, Blue Bevel is associated with the templates Business, 
Business TOC, and Business Index). 

However, when you move away from the template settings themselves (or start with the default 
or Blank template), you need to give careful thought as to how to handle content. That’s not to 
say that everything should end up looking the same (in some instances, you may even be 
seeking contrast rather than consistency). But you should avoid, for example, using too many 
different fonts or colors. In fact, you can achieve a surprising amount by the judicious use of 
text options, using those available with CSS turned on.

Take another look at your publication in your browser. Let’s do a couple of things in the main 
frame that will be compatible with the TOC. One thing might be to key Title text the same 
color and in a similar font. 

 1.  Select one of the source documents (and thus the Business template) and click Edit 

Template on the toolbar ( ).

We’re still dealing with the elements Title and Intro, of course (you can pass your cursor 
over the Preview window in the Edit Template dialog box to confirm), but this time for 
the body pages.

 2.  Click Formatting. Select Title and apply a new font, size, and color to the element, just 
as you did for Title in the Abstract template. 

You might choose Arial Black again, but this time set it larger (say, 14 points). You might 
also choose the color red, so that the title will be tied visually to the same text in the TOC. 
Finally, you might turn off italic, which is used in the source document. (In the Effects 
dialog box, select Always Off from the Italic drop-down list.)

 3.  Format the Intro element also, making it Arial and 9 point (thus slightly larger than for 
the same text in the TOC). 

 4.  Click OK to return to the Edit Template dialog box (you’ll see your changes in the 
Preview window). Click OK, again, to return to the main window. 

 5.  Translate and view your revised Web publication. This is just a simple example of relating 
TOC content to the body pages. 

Tips

 1.  CSS is template-based. You can turn on the CSS option for all templates in your 
publication, some, or none at all. Those templates with “CSS” as part of their name 
already have CSS turned on.

 2.  Keep in mind the need for a compatible look between frames. The more frames you have 
in your frameset, the greater the need to control the number of fonts you use. 

 3.  The Edit Template dialog box lets you preview your changes as you make them. It also 
facilitates editing, thanks to tooltips in the Preview window that identify element names. 
Finally, it simplifies the process of moving between the different property sheets 
(Element Setup, etc.).

 4.  Remember: implementing CSS is not always predictable. You may get different results, 
depending on which browser you are using. Moreover, whichever browser you do use, 
what you see onscreen in your browser may be different from what you print out.
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LESSON 3

Formatting Tables

Source documents often contain tables. With Site Builder’s wide range of formatting options, 
you can not only format the content of tables in special ways, but also format their appearance. 

Ideally, to format content, you should use unique styles in the source documents. In that case, 
you simply select the appropriate elements from the Elements list in Formatting and format 
those elements, using options in the Character and Paragraph tab dialogs. However, if the same 
styles have been used for table content as for other content in the source documents, you can 
still format table content differently from the rest of the document by using the Table Overrides 
feature.

To format the appearance of a table, you use the Tables tab dialog in Formatting. To do so, 
however, you must select the element for the content immediately before the table. This is 
necessary because, while the content of a table can have its own styles, the table itself doesn’t 
have a style. So Site Builder identifies a table by using the style immediately preceding the 
table. 

While this may seem confusing at first, it actually increases the options available to you for the 
treatment of tables in your Web pages. Among the formatting options for table appearance are 
changing table borders, altering table cell size, and changing the color of cell background.

In this lesson, you will

! Format the appearance of a table

! Format the content of a table, using both a unique element and the Table Overrides 
feature

Format the appearance of a table

 1.  Open Tables.tcp in the ..\Stellent Content Publisher\Samples\en subdirectory.

 2.  In the Contents pane, select Other Issues.doc and click Formatting on the standard 

toolbar ( ).

 3.  From the Elements list, select Caption and switch to the Tables tab dialog.

Caption is the style for the content that immediately precedes the table in the source 
document.

 4.  Under Appearance, click the Alignment button.

 5.  Under Table Horizontal, click Use this alignment, and select Center from the drop-down 
list. Note how the sample table in the Preview box has changed.
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Figure 3-1  The Alignment tab dialog for formatting the appearance of tables.

 6.  Switch to the Colors tab dialog. Under Table Border, click Use this color, and then click 
the Color button to open the Colors tab dialog. Pick a dark blue and click OK to return to 
the Colors tab dialog in Tables. Note how the sample table in the Preview box has 
changed again.

 7.  Click OK to return to the Tables tab dialog.

Now you’ll format table content. The table in Other Issues.doc contains two styles: TableHead 
is used only in the table, whereas Normal is used elsewhere in the document. 

Format the content of a table

 1.  From the Elements list, select TableHead and switch to the Character tab dialog.

 2.  Under Font Color, click Use this color, and then click the Color button to open the Color 
dialog box. Pick a red and click OK to return to the Character tab dialog.

 3.  Switch to the Paragraph tab dialog. Under alignment, click Use this alignment and select 
Center from the drop-down list.

You have formatted TableHead. This formatting will affect only the heading text of the table. 
To format Normal, however, you’ll have to use Table Overrides because this element is found 
elsewhere in the source document.

Format content by using Table Overrides

 1.  From the Elements list, select Normal and switch to the Character tab dialog.

 2.  Under Tables Overrides, click Override when a table and then click the Character 
button.
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Figure 3-2  Using Table Overrides to format the Normal element.

 3.  Under Font Color, click Use this color and click the Color button. In the Color dialog 
box, pick a dark green, and then click OK to return to the Character tab dialog.

 4.  Click OK to return to the main window.

You have saved all your changes to the template. You must now save them to the project 
file.

 5.  Click Save on the toolbar ( ).

 6.  Click Translate on the toolbar ( ) to translate your publication.

 7.  In the Contents pane, select Other Issues.doc and click View on the standard toolbar 

( ) to view your Web page. See Figure 3-3.

Scroll to the table. The table border is dark blue, the TableHead text is red and centered, and the 
Normal text in the table is dark green. But the rest of the Normal text in the web page is still 
black. (The text in the Web site column of the table is a different color because it is linked. The 
colors for links are set in the Colors tab dialog of the Globals property sheet.) 
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Figure 3-3  By using Table Overrides, it was possible to format the text within the table 
differently from the body text in the document. 

Tips

 1.  Table Overrides is one example of being able to turn off a formatting feature in a specific 
context. As another example, on the Separators tab dialog you can choose to omit the 
separators when an element is within a table. 

 2.  As you discovered in this lesson, in order to format the appearance of a table, you must 
select the element that immediately precedes the table. But if the styles preceding your 
tables vary, and you want to format all your tables the same way, the solution is simple. 
Since you can format multiple elements simultaneously, you only have to complete 
settings in the Tables tab dialog once. Simply identify the appropriate styles in your 
source documents, and then select the elements for all of those styles from the Elements 
list before using the Table tab dialog. 

 3.  If a table is at the very top of a source document, with no content preceding it, the element 
Default Paragraph is associated with the table and can be used to format its appearance.
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LESSON 4

Formatting Bulleted Lists

Lists pose a special challenge when you’re creating Web pages. Web browsers interpret the 
<LI> list tag by placing either bullets or numbers before list items. This can cause a “doubling 
up” effect in Web pages. To avoid this, Site Builder doesn’t automatically assign the list tag 
when it imports styles or patterns. As a result, bullets or numbers “pass through” during 
translation without this effect.

For best results in formatting lists, each list type should have its own unique style and you 
should assign the <LI> list tag to the element that Site Builder generates from that style. If the 
lists in your source documents don’t have unique styles, you can still use Site Builder’s pattern 
matching capabilities to search for bulleted or numbered text and assign an element to that 
pattern. This will be necessary, for example, if you have used the AutoFormat feature in your 
word processor to create bulleted lists. 

In this lesson, you will

! Create a pattern to search for a bulleted list

! Format a bulleted list

In Lesson 5, you will learn how to handle numbered lists.

 1.  Open Lists.tcp in the ..\Stellent Content Publisher\Samples\en subdirectory.

 2.  In the Contents pane, select Publishing Process.doc, and click Edit Template on the 

toolbar ( ). (Publishing Process.doc contains the bulleted list you’ll format in this 
lesson.)

In the Preview window, scroll to the bulleted list at the end of the document. (If the Auto check 
box is clear, either select the box or click the Update Now button.) This list was added by using 
the Bullets feature in Word, and is currently part of the Normal style. Note how small the 
bullets are. This is a common problem with lists in Web pages. 

Create a pattern to search for a bulleted list

 1.  Click Element Setup ( ).

 2.  Switch to the Patterns tab dialog, and then click New to open the New Pattern dialog box.

Figure 4-1  The New Pattern dialog box with the new pattern named and associated with a new 
element. 

 3.  In the Name text box, type List Bullet (see Figure 4-1)
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 4.  Click the New button next to the Associated Element drop-down list to open the New 
Element dialog box (Figure 4-2).

 5.  In the Name text box, type List Bullet, and select <LI> from the drop-down list of 
HTML tags. Then click OK to return to the New Pattern dialog box. 

When you associate the <LI> tag with an element, this tells the browser that the following 
text is a list. The formatting for a list is different than the formatting of the body text. So 
you need to assign this tag to any element associated with a list. 

 6.  List Bullet now appears in the Associated Element text box. Click OK to return to the 
Pattern tab dialog.

Figure 4-2  The New Element dialog box, where you create new elements.

 7.  From the Patterns list, select List Bullet and click Properties.

 8.  Click Text Expression to open that tab dialog.

 9.  Under Text Paragraph Position, select Beginning, and in the Text Expression text box 
place the cursor between the quotation marks.

 10.  Under Common Character Definitions, click, in turn, the Bullet button, the Tab button, 
and the Any Character button.

Your pattern in the Text Expression text box should look the same as the one in Figure 4-
3.

 11.  Click OK to return to the Patterns tab dialog, and OK again to return to the Edit Template 
dialog box.
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Figure 4-3  The Text Expression dialog box, with a pattern created for a bulleted list.

Site Builder has now updated your Web page in the Preview window. (If Auto is not checked, 
click the Update Now button.) Scroll to the end of the document and you’ll see that a second 
set of bullets has been added to the list, to create a “doubling up” effect. That’s because you 
used the <LI> tag for the new pattern. You can now format the pattern to change the new 
bullets and strip out the old ones. 

Format the bulleted list

 1.  Click Formatting.

 2.  From the Elements list, select List Bullet.

 3.  Click Lists to open that tab dialog. 
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Figure 4-4  The Lists tab dialog in Formatting, where you format lists.

 4.  Under Type, select Bulleted List. 

 5.  Under Bullet, click the Bullets button. 

 6.  In the List Bullets dialog, select Use custom bullet. 

As a graphics Set has already been associated with the template, the path and file name 
for the bullet from that Set displays immediately in the File Name text box. 

 7.  Click OK to return to the Lists tab dialog. The bullet from the graphics Set now displays 
in the Sample box in the Bullet panel, as well as in the Preview box.

 8.  Click Strip input to first blank space or tab. (Note the change in the Preview box.)

 9.  Click OK to return to the Edit Template dialog box.

Scroll to the end of the document and you’ll see that new bullets have been added to the 
list and the old ones have been stripped out.

With Lists.tcp still open, you can go straight to the next lesson, on numbered lists.
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LESSON 5

Formatting Numbered Lists

As we noted in the previous lesson, lists pose a special challenge when you’re creating Web 
pages. As with bulleted lists, best results are obtained in formatting numbered lists by using 
unique styles for the list content and assigning the <LI> list tag to the elements that Site 
Builder generates from those styles. 

The numbered list you will format in this lesson is easier to deal with because it already has a 
unique style associated with it. But the list tag has not been assigned, and the list has “mixed 
styles.” That is, in addition to the style used for each numbered item (List Number), a second 
style (Indent) has been used for the second paragraph that follows some of the items. 

A common problem with mixed styles is that browsers often interpret each number after the 
second style as being the start of a new list, and so start renumbering the list. Fortunately, Site 
Builder has a way around this.

In this lesson, you will

! Change the HTML tag assigned to an element 

! Format a numbered list

You should have Lists.tcp still open and Publishing Process.doc displayed in the Edit Template 
dialog box.

 1.  Under Preview, click the Change Preview button to open that dialog box.

 2.  From the list of source documents, double-click User Interface.doc. 

The Preview window in the Edit Template dialog box now updates to display the second 
document in the publication, User Interface.doc. 

 3.  Scroll to the numbered list near the end of the document.

To format this list, you need to assign the <LI> tag to the element associated with it. You did 
this already for the Bulleted list, when you created the new element. 

Change the HTML tag assigned to an element

 1.  Click Element Setup on the toolbar ( ).

 2.  From the Element list, select List Number, and click Properties. (List Number is the 
style used for the list items.)

 3.  Click HTML Tag to open that tab dialog (see Figure 5-1).

 4.  Click Use standard tags, and select <LI> from the Tag drop-down list.

 5.  Click OK to return to Element Setup, and OK again to return to the Edit Template dialog 
box.

In the Preview window, scroll to the list, which now has bullets in addition to numbers. This 
happened when you assigned the list tag to List Number. So let’s format List Number to 
eliminate this problem.
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Figure 5-1  The HTML Tag tab dialog in Element Properties, where you can change the HTML 
tag assigned to an element.

Format the numbered list

 1.  Click Formatting to return to that property sheet.

 2.  From the Elements list, select List Number.

 3.  Click Lists to open that tab dialog (see Figure 5-2).

 4.  Under Type, select Numbered List.

 5.  Under Numbering Type, accept the default, and under Numbering Values, select Take 
from source. This option ensures that the list will retain its original numbering when Site 
Builder translates the source document. (Because of a browser limitation, this option 
works only for the numbering type 1, 2, 3….)
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Figure 5-2  This tab dialog is where you apply formatting to lists.

 6.  Click Strip input to first blank space or tab (note the change in the Preview box).

 7.  Click OK to return to the Edit Template dialog box, and OK again to return to the main 
window. 

 8.  Click Save on the toolbar ( ) to save the project file and all your template changes.

 9.  Click Translate on the large toolbar ( ).

 10.  In the Contents pane, click View ( ) to view your Web page.

You don’t need to select one of the output pages. Since the publication doesn’t have a 
frame, Site Builder will open the first output page listed. (The two documents are linked 
by navigation buttons, so it doesn’t matter which page you open first to view your Web 
publication.)

Navigate between the two pages (navigation buttons are at the top and bottom of each page), to 
see how the two lists appear now. Publishing Process contains the bulleted list, while User 
Interface contains the numbered list. 

Tips

 1.  When you format a list, the list ideally should have its own style. You can always “pass 
through” lists, because Site Builder doesn’t automatically apply the list tag <LI> to lists. 
But this limits your formatting options.

 2.  If a list doesn’t have a unique style, it’s relatively easy to create a pattern to find the list 
content, especially if the list begins with a bullet or number followed by a tab. If the 
bullets used aren’t part of the style used for the list, but are from another font (say, 
Symbol), you may need to search for any character, followed by a tab, or choose to search 
for that font. What matters is that you create a pattern unique to the list so that Site 
Builder can search for that pattern to format the list.
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 3.  Another issue is what happens when you have “mixed styles.” If you have a numbered 
style followed by an unnumbered style, as in Publishing Process (where the List Number 
style was followed by Indent), the browser will begin numbering over again each time 
there’s a break in the list, that is, immediately after the second style (Indent, in our 
example). By selecting Take from Source, you told Site Builder to keep the same 
numbers as in the source file. 
30



Content Publisher
LESSON 6

Working With Graphics

Graphics are an integral part of most Web pages. A complicated page with many graphics may 
take a long time to download and may even drive readers away, while a Web page without 
graphics may seem dull. So the trick is to achieve a judicious balance between graphics and the 
other content. In creating Web pages, you can add navigation and other visual aids to assist 
readers. But the treatment of graphics begins with how you handle those graphics already in 
your source documents.

Site Builder converts graphics into the GIF, JPEG, PNG, or BMP format (the WBMP format is 
available for WML projects). If they are in one of those formats already, and they are externally 
linked in the source documents, they are simply “passed through” unchanged. If they are 
embedded in the source documents, the graphics are converted according to the settings in the 
Graphics tab dialog in Formatting (the default is GIF for an HTML project, WBMP for a 
WML project). Like most content in Site Builder, you format a graphic by selecting the 
element associated with the graphic. So if you have several graphics associated with different 
elements, you must format each element, in turn.

On the other hand, by using unique elements for different graphics, you can format the graphics 
individually. Even if your source document is manually formatted, you can create a pattern to 
identify paragraphs that contain the graphics and use that pattern for formatting purposes. 

In this lesson, you will

! Convert a graphic into a GIF and make a color in that graphic transparent

! Convert a second graphic into a JPEG and create a thumbnail for it

The source document for this lesson contains two bitmaps. The first is embedded in the text 
and associated with the Normal style. The second is linked to the document and has its own 
unique style, Screen Shot.

Convert a graphic into a GIF and make a color transparent

 1.  Open Graphics.tcp in the ..\Stellent Content Publisher\Samples\en subdirectory.

 2.  In the Contents pane, select Other Issues.doc and click Edit Template ( ).

In the Preview window, click the Next Page button and use the scrollbar to move through 
the content. Note the embedded graphic “New” on one page. The letters are white on a 
yellowish background, and the graphic sits on the baseline of the text. On another page, 
the second graphic — a screenshot — is full-size.

 3.  Click the Formatting button to open that property sheet. 

 4.  From the Elements list, select Normal (the style associated with the embedded graphic) 
and switch to the Graphics tab dialog. You can use the arrow button at the upper right to 
display more tabs.

 5.  Under Format, accept the default GIF. The graphic associated with the Normal style will 
be converted into a GIF. 

 6.  Click Make this color transparent. Then click the Color button and in the Color dialog 
box select white. Click OK to return to the Graphics tab dialog.

 7.  Under Alignment, select Top. 
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Since this graphic is embedded in the text, it is important to set its relationship to the text. 
Top aligns the top of the graphic with the line of text, Middle aligns the middle of the 
graphic with the line of the text, and Bottom aligns the bottom of the graphic with the line 
of text. 

Left Text Edge and Right Text Edge will align the graphic to either the left or the right of 
the column, with the text alongside. Center will place the graphic in the center of the page 
on a line by itself. 

 8.  Click OK to return to the Edit Template dialog box. View the graphic you have just 
edited. Note how its position has changed — the top of the graphic now aligns with the 
cap height of the text — and the white lettering has become transparent to allow the 
background color of the graphic to show through.

Convert a graphic into a JPEG and make it a thumbnail

 1.  Click Formatting again to open that property sheet.

 2.  From the Elements list, select Screen Shot (see Figure 6-1). 

 3.  Under Format, click JPEG.

 4.  Under Alignment, accept the default, None. Since this graphic is on a line by itself, 
alignment doesn’t matter.

 5.  Click Create a link to the graphic and Link using thumbnail. Then click Thumbnail 
Size to open that dialog box, and select 1/16 full graphic from the drop-down list. Click 
OK.

The graphic associated with the Screen Shot element will now be converted into a JPEG 
and will display as a thumbnail (with a link to the full-size graphic.)

 6.  Click OK to return to the Edit Template dialog box. Check the new thumbnail graphic in 
the Preview window. Then click OK to return to the main window.

 7.  Click Save on the toolbar ( ) to save the project file and the template, and then click 

Translate ( ).

Figure 6-1  The Graphics tab dialog in Formatting.
32



Content Publisher
 8.  Select Other Issues and click View ( ) to view the Web page you have just created 
(see Figure 6-2).

When you view the Web page you’ll see that the first graphic (associated with the Normal 
element) hasn’t changed this time. But the large screen shot (associated with the Screen Shot 
element) is now a JPEG and is linked to a thumbnail. When you click the thumbnail, the 
graphic displays full size in the browser window by itself (you can click Back to return to the 
Web page).

By turning the large graphic into a thumbnail, you’ve improved the download time of the page. 
Also, thumbnails take up less screen space. There isn’t much difference when you have just 
one, but with many graphics, it can make a big difference.

Figure 6-2  The second graphic seen as a thumbnail in the browser.

Tips

 1.  You have the choice of linking or embedding your graphics. When you link a graphic, text 
or a thumbnail will display on the page. The reader will need to click the link to see the 
full-size graphic. If you embed the graphic, the graphic will display full-size. In both 
cases, Site Builder creates a separate file for the graphic and saves it to the Graphics 
output directory. The difference is how the graphic displays in the browser.

 2.  While a number of different graphics formats are used on the Web, GIF and JPEG are the 
most common. The different formats work best for different graphic types. GIF is best for 
graphics such as bar charts and line drawings that have large blocks of flat colors, with 
consistent color and no shades. JPEG was developed specially for photographs and 
therefore is best for graphics with variations in colors and lots of shading. PNG is a GIF 
alternative that offers better compression and more transparency options. BMP is now 
supported by more browsers. WBMP is best for use with WML projects.

 3.  Thumbnails are always GIFs, no matter which option you choose for converting full size 
graphics.
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LESSON 7

Introducing Navigation

Navigation can take many forms. In this lesson, we’ll look at text bars and button bars, both of 
which can play an important role in helping the user navigate a Web publication. 

Both text and button bars can be placed at the top or bottom of a page (or both), as well as 
associated with elements on a page. Text bars draw their content from elements in the template 
and are used to navigate specifically to that content. Button bars perform a more general role, 
typically allowing users to move back and forward through a publication, or to link to other 
means of navigation, such as a TOC or Index. 

Site Builder has added a Top of Project button to the traditional repertoire of navigation 
buttons. With this button, the user can return to the top page of a Web publication from 
anywhere in it. This button can be especially useful in a highly complex Web publication.

Site Builder also boosts the power of navigation button bars by allowing links beyond the Web 
publication itself. Three “specific page” links are available to connect to any URL anywhere. 
In addition, a Link to Source button can allow you to place a link in a Web page that will open, 
in its native format, the source document that was used to create the Web page. Finally, a 
special Print button can be inserted anywhere in your publication to let the user print all or 
select portions of the publication at any time.

In this lesson, you will

! Create a page text bar

! Add Link to Source and Print navigation buttons 

! Change the layout of the page and text bars at the top of the page

Create a page text bar

 1.  Open Textbars.tcp in the ..\Stellent Content Publisher\Samples\en subdirectory.

 2.  Select one of the source documents and click Navigation on the toolbar ( ). As you’re 
editing the template, not the source documents, it doesn’t matter which source document 
you choose.

First, in the Page Button Bar tab dialog, take a quick look at the default buttons set for the 
Executive template. As you can see, four are set both at the top and bottom of each page, 
while the Top of Page button is set at the bottom only. These buttons are from the Gray 
Tab graphics Set, which is associated with the Executive template.

 3.  Click Page Text Bar to open that tab dialog (see Figure 7-1).

 4.  Click Build a text bar from all and select Title from the drop-down list. Accept the 
default (2) from the Using the first drop-down list. (This means the text bar will be 
created from the first two words of each Title.)

 5.  Make sure that the Strip input to first blank space or tab check box is clear.

If your titles include chapter numbers (like the titles of these lessons), this option will 
remove them. If they don’t include numbers, you should clear this check box to avoid 
losing the first word of each title.
35



Content Publisher
Figure 7-1  The Page Text Bar tab dialog. With CSS turned on (as shown here), options in the 
Font panel will let you format text bars more precisely. 

 6.  Under Placement, select Top of page and Bottom of page. Under Alignment, accept the 
default, Center.

 7.  Under Font, click Use this font and select Arial or another sans serif font from the drop-
down list. (The fonts available will be those on your machine.)

 8.  Click Use this size. Accept the default Absolute and select 2 from the drop-down list.

 9.  Click the Bold check box.

You have just created a page text bar that will display the titles of all four documents in this 
publication. You can use these text bars to navigate between pages. Let’s take a look at the 
result.

 1.  Click OK to return to the main window and click Save ( ).

 2.  Click Translate ( ). 

 3.  Click anywhere in the Contents pane below the list of files to ensure that no file is 

selected, and then click View ( ).

Note what has happened. First, with no output page selected in the Contents pane, the browser 
opened the first page listed — Publishing Process (see Figure 7-2).

Second, the page text bar appears near the top of the Web page, just as you formatted it and 
with links to all four pages. (By the way, the default colors for these links are as set in the 
template, on the Colors tab dialog in Globals.) By clicking an entry in the page text bar, you 
can jump from page to page. (When you jump from one page to the next, you jump to the 
actual link, that is, to the page title. You then need to scroll to the top or bottom of the page to 
access the page text bar on that page.)

Third, the browser displays only those navigation buttons essential to navigate the publication. 
Although TOC and Index buttons are default settings for the Executive template (as you’ll 
recall from the Page Button Bar tab dialog), these have dropped out because the publication 
does not contain a TOC or an Index. 
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The Previous Page button is still in the publication, but it isn’t required for the first page. It will 
appear as soon as you click Next to move to the next page in the publication (Page Navigation). 
Finally, if you scroll down to the bottom of the page, you will see the Top of Page button, 
which is also a default setting for the Executive template.

Figure 7-2  The browser with the new page text bar. The page button bar has more buttons set 
in the template, but only buttons essential to navigation display on each Web page. 

Add Link to Source and Print buttons

 1.  In the Contents pane, select one of the source documents and click Navigation again. 

 2.  In the Page Button Bar tab dialog, under Link Type, select Link to Source and double-
click in the Before column opposite the link.

The “Get Source” button appears immediately in the Top of Page preview window and 
the path and file name for the graphic appear in the Link Icon column. (This button is 
from the Gray Tab graphics Set.)

 3.  Now select Print in the Link Type column and again double-click in the Before column. 

This time the Print button appears in the Top of Page preview window and the path and 
file name for this graphic appear in the Link Icon column.

 4.  If necessary, use drag-and-drop to move both the Print and Get Source buttons in the Top 
of Page preview window so that the buttons are aligned as shown in Figure 7-3. (Where 
possible, it is helpful if specific buttons appear in the same order in button bars at both the 
top and bottom of a page.)

 5.  Click OK to save your changes to the template and return to the main window.
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Figure 7-3  The Page Button Bar with Link to Source and Print buttons added and rearranged 
in the button bar in the Top of Page preview.

Change the layout of the navigation bars at the top of the page

Let’s complete one last task before we view the results. 

 1.  With one of the source documents selected in the Contents pane, click Globals to open 
that property sheet and then click Layout to open that tab dialog. (You may need to click 
the right arrow button at the upper right of the property sheet to reveal the Layout tab.)

 2.  In the Layout tab dialog, grab “Text Bar” with the mouse and drag it above the three red 
button arrows that represent the page button bar. 

 3.  Click OK to return to the main window.

 4.  Click Save ( ) and then Translate ( ).

 5.  Click View ( ). Figure 7-4 shows the final version, with the Print and Get Source 
(Link to Source) buttons added and the page text bar now at the top of the page (compare 
with the browser view shown in Figure 7-2). 

 6.  Click the Print button. If you are using Internet Explorer, the Select Files to Print dialog 
box opens. You can select any combination of pages you want to print. (See Tip 5.)

 7.  Click the Get Source (Link to Source) button and the source document used to create the 
Web page will open in its native format.
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Figure 7-4  The final button and text bars. The layout of the two bars can be changed in the 
Layout tab dialog of Globals.

Note: Depending on which browser you are using and the native format of the source 
document, the document may open in your browser viewer, not the application used to create it. 
If so, you will still be able to edit the document, if you want, in your browser. Once you save 
your changes, you can then click the Back button on the browser toolbar to revert to your Web 
publication.

Tips

 1.  The successful use of text bars rests on the careful creation of headings in the source 
documents to begin with. Even if the entries in a text bar are complete (you have created 
the text bar by picking up all the words in each heading), you may find that some 
headings are less than useful when they are no longer in the immediate context of the 
content they’re related to. 

 2.  If you view page and element text bars in the Preview window in the Edit Template dialog 
box, keep in mind that the Preview window can only display one source document at a 
time. So the text bars may not always display all possible entries for the text bar. That is, 
the text bars won’t necessarily appear as they will in your Web browser once you translate 
your publication.

 3.  If the template you are editing has cascading style sheets (CSS) turned on, your 
formatting options in Navigation are even greater. You will find that you can select 
Custom in both the Page Text Bar and Element Text Bar tab dialogs and set a precise 
point size in one of several units of measure. 

 4.  When setting up a project, you can actually create a page button bar with more navigation 
buttons than you may need right away. Site Builder will display only those buttons 
required for navigation in a publication. The templates that ship with Site Builder 
typically have all the buttons you saw in Executive already preset.

 5.  The Print button functionality is fairly straightforward, thanks to certain default settings 
in Site Builder. (For more information, open online Help and select the entry “print 
functionality, enabling” from the Index.) However, its functionality differs between 
Internet Explorer and Netscape Navigator. With Internet Explorer, you will be able to 
print all or selected portions of your publication from wherever the Print button resides on 
your publication. With Netscape Navigator, the Print button works the same way as the 
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Print button on the browser toolbar. That is, it prints only the page currently displayed in 
the browser.

 6.  You may want to explore the Link Properties dialog box in Navigation. For example, in 
the Page Button Bar tab dialog, select Link to Source and then click Properties. The 
dialog will display the information shown below. Note, in particular, the default source 
page URL. This was fine for our purposes in this lesson. But you may need to consider 
alternative URLs for different Web publications. Open online Help and select the entry 
“Optional URLs for linking to a source document” from the Index.
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LESSON 8

Creating Titles

Titles are an important part of a Web publication. They help readers identify the structure and 
content of the individual Web pages that make up the publication. 

Source documents often have titles, which you can promote in Site Builder and, for example, 
automatically link from a TOC. But if, say, you have legacy documents that do not have titles, 
or you want to impose a general title or series of titles on those documents as they will appear 
in your Web publication, Site Builder automates the process of both creating titles and placing 
them in your Web pages.

Site Builder uses four components to create a title: publication, Directory Item, source 
document, and (in the case of a split document) page. You can use one, any two or three, or all 
four of these components. And once you’ve created the title, you can place it at the top of each 
Web page of your publication. You can also place the title in the title bar of the Web browser 
(but with framesets, the title is created a different way).

In this lesson, you will

! Learn how to set up the three of the four components of a title: Publication, Document, 
and Page

! Place the title both in the pages of the Web publication and the title bar of your Web 
browser

! Review what happens when you use a frameset

Set up the title

 1.  Open Titles.tcp in the ..\Stellent Content Publisher\Samples\en subdirectory.

 2.  In the Contents pane, select Publishing Process.doc and click Globals on the toolbar 

( ).

 3.  Click Titles to open that tab dialog (see Figure 8-1).

There are two options under Title Placement for the placement of the title. The first will place 
the title in the <TITLE> tag of your HTML file. As a result, it will display in the title bar of the 
Web browser. It will also be used in the Bookmark and past history lists, possibly even by 
search engines as the site identifier. 

The second option places the title at the top of your Web page. In this case, the title is 
associated with the special element Title (System). Don’t confuse the elements Title and Title 
(System). If your template has an element Title, that’s because you have a style or pattern in 
your source document of that name. Typically, it would represent the opening text (chapter 
title, say) at the beginning of the document. On the other hand, all the “system” elements are 
special elements created by Site Builder (they come with every template). Title (System) is 
used specifically to format the title you create when you choose the second option under Title 
Placement.
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Figure 8-1  In the Titles tab dialog you determine a title’s content and its placement.

 4.  In the Title Placement panel, check Place a title in the body of the Web pages (see 
Figure 8-2).

Incidentally, this is the same as including Title (System) in the body of the document (that is, 
changing the red cross to a green check mark in the In Body column of the Elements tab dialog 
in Element Setup). Now you’ll step through the process of adding the components of the title, 
one by one. 

Figure 8-2  This Title Placement panel controls where the title appears.

Set the publication component of the title

The publication component is a property of the publication. The content is taken from the 
Publication Title entry in the Publication Properties dialog box. By default, the title is the name 
of the publication, but you can change it, if you want. 

 1.  In the Title Contents panel, click The publication component (see Figure 8-3).

 2.  Click OK and return to the main window.

 3.  In the Publication Hierarchy pane, right-click Creating titles (the root publication) and 
choose Properties from the popup menu to open the Publication Properties dialog box.

 4.  In the Publication Title text box, select “Creating titles” and type Publication 
Component to replace the default title. Then click OK to return to the main window.
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Figure 8-3  The Title Contents panel controls which components are included in the title.

 5.  In the Contents pane, select Publishing Process.doc and click Edit Template on the 

toolbar ( )  to open that dialog box.

In the Preview window, you’ll see the words “Publication Component” at the very top of 
the page. Change the preview to any other document in the publication and you’ll see this 
title on that page, too. You can use the Title (System) element to format the new title.

 6.  Click Formatting. From the Elements list, select Title (System).

 7.  In the Character tab dialog, under Font Color, click the Color button to open the Color 
dialog box. Pick orange and click OK to return to the tab dialog, where a sample of the 
color now displays in the color box under Font Color (and also in the Sample box below).

 8.  Under Font Size, change the size to 6. 

Since Use this size and Absolute were previously set for this template, you just need to 
change the size.

 9.  Click OK to return to the Edit Template dialog box.

The title is readily apparent at the top of the page. You can see that its color and size have 
changed according to the template changes you have just made. This title will be the same 
for all the pages in the publication. 

Set the document component of the title

The next step is to specify the document component. This is set under Document Component 
of Title in the Titles tab dialog. 

 1.  Still in the Edit Template dialog box, click Globals and switch to the Titles tab dialog.

 2.  In the Title Contents section, click The document component.

In the Document Component of Title panel (see Figure 8-4), you essentially have two choices. 
You can use the content from one of the elements in the template to create the component. 
Since the Title element is an obvious choice, you can click the Title radio button in the panel. If 
you prefer another element, you can select it from the drop-down list of elements. 

Alternatively, you can use the title specified in the Document Properties dialog box. To view 
any title, right-click the appropriate document in the Contents pane and choose Properties from 
the popup menu to open the Document Properties dialog box. The title will be listed in the 
Titles text box. By default, it has the same name as the document. In this lesson, you’ll choose 
each option, in turn, starting with the element.

 3.  Select Use content from the first occurrence of the following element.

 4.  Select Title.
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Figure 8-4  The Document Component of Title panel, where you select the document component 
of the title.

Site Builder will now use content from the Title element for the document component of the 
title you’re creating for the publication, and this will appear at the top of each Web page 
immediately after the publication component.

 5.  Click OK to return to the Edit Template dialog box. The title now reads “Publication 
Component Publishing Process.” Of course, the document component will change as you 
navigate between the pages of the publication.

 6.  Click OK to return to the main window.

As mentioned, you can, instead, use the title in the Document Properties dialog box for the 
document component of the title. Let’s try that.

 1.  In the Contents pane, right-click Publishing Process.doc and choose Properties from the 
popup menu to open the Document Properties dialog box.

 2.  In the Document Title text box, select “Publishing Process” and type Document 
Component to replace the default title. Then click OK to return to the main window.

You’ve changed the title of only this source document, Publishing Process.doc. If you 
open Document Properties for any of the other source documents, you’ll see that the 
document title there is still the same as the document name.

 3.  In the Contents pane, select Publishing Process.doc again, and click Edit Template on 

the toolbar ( ) to open that dialog box.

 4.  Click Globals and switch to the Titles tab dialog. 

 5.  Under Document Component of Title, click Use the title specified in the document 
properties. Click OK to return to the Edit Template dialog box.

The title in the updated Web page in the Preview window now reads “Publication 
Component Document Component.”

Set the page component of the title

When you split a source document into a series of smaller pages, you can use options in the 
Page Component of Title panel to add a further level of information to the title.

 1.  Click Globals and switch to the Titles tab dialog. 

 2.  Under Title Contents, click The Page Component.

 3.  In the Page Component of Title panel, click Use the following text, and in the text box 
type Page Component (see Figure 8-5).

The content of the text box will now be added to the title, and will appear immediately 
after the document component.
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Figure 8-5  The Page Component of Title panel is only relevant if you have split a source 
document into multiple pages.

 4.  From the Page Numbering drop-down list, select A, B, C, D. 

 5.  Click OK to return to the Edit Template dialog box.

Review your document once again in the Preview window. The title now reads “Publication 
Component Document Component Page Component A.” Click the Next Page button. As you 
can see, the title stays the same, except that the A changes to B. (When you split a document, 
you can move between the pages in the Preview window.)

Say you change the page component in the Titles tab dialog setting to Use content from the 
first occurrence of the following element and select Heading 1 from the list of elements. In 
that event, the title of the first page would read “Publication Component Document Component 
Servers and Staging A,” and for the second page it would read “Publication Component 
Document Component File Transfer B.”

 6.  Click OK to return to the main window, and then translate and view the Web pages.

When you browse from page to page, you can see the changes in the Title at the top of the page. 
You can also see that the browser title bar displays the path and name of the file. This is not 
very descriptive of the page’s content. The next step is to add the title to the title bar, that is, to 
the <TITLE> tag. 

Adding the title to the title bar of the Web browser

 1.  In the Contents pane, select any source document and click Globals on the toolbar.

 2.  Switch to the Titles tab dialog. 

 3.  Under Title Placement, check Place a title in the title bar of the Web browser.

 4.  Click OK to return to the main window.

 5.  Click Save on the toolbar ( ) to save the project file and all the template changes. 

 6.  Click Translate on the large toolbar ( ).

 7.  Select one of the source documents and click View on the large toolbar ( ) to open the 
Web browser.

The title now appears in the application title bar of the browser in addition to the top of each 
Web page (see Figure 8-6). 
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What happens when you use a frameset

Figure 8-6 shows the title you created in the title bar of the browser. When your publication has 
a frameset, however, the title of the frameset itself takes over.

 1.  In the main window, click Layout on the standard toolbar ( ) to open the Layout 
dialog box. Under Active Layout, select Frame Layout.

 2.  Click the New Vertical button. Immediately, Site Builder creates a frameset consisting of 
two frames, and assigns the TOC to the first frame and body pages to the second.

 3.  Click the Frameset Properties button to open that dialog box. Note the default frame 
title, “FrameTitle.”

 4.  Click OK, and OK again to save the frameset you created and return to the main window.

Figure 8-6  Note that the title now displays in the title bar of the browser. You handle titles 
differently when you use framesets.

 5.  Click Translate on the toolbar ( ) and then View ( ). 

The Web publication opens with the frameset (no matter what you select in the Contents 
pane). Note what now displays in the title bar of the browser (Figure 8-7).
46



Content Publisher
Figure 8-7  When you use a frameset, the frameset title displays in the browser title bar.

Tip

When you create a frameset, just remember that the frameset title is what will appear in the 
browser title bar. However, you may still want to create a title for the <TITLE> tag of your 
output pages. Although the title information won’t display in the browser, it could still be 
useful, for example, if it were to be accessed by search engines. Moreover, you might want to 
create JavaScript to introduce more power into your Web publication and conceivably you 
might want to access the title information that’s placed in the <TITLE> tag.
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LESSON 9

Handling Ranks, Styles, and Patterns

A preliminary goal in project setup is to map the content of your source documents to elements 
so that you can use the elements to format your Web pages. Elements are also useful in other 
ways, such as to promote content and create navigation links. So the more successful you are in 
mapping content, the greater your flexibility in creating Web publications.

Site Builder does much of this mapping for you. In fact, no matter how you bring a source 
document into Site Builder, if the document is in one of the supported formats, you will always 
be able to translate it and create good-looking Web pages. 

This may, in fact, be all that you have to do, if you don’t need to format content in special ways. 
But if you want your Web pages to enjoy a high degree of visual appeal and functionality, you 
will probably want to refine the initial set of elements that you see when you first add 
documents to your project. How successful you are in mapping content to elements will depend 
on the nature of your source documents and how you choose to handle them.

Ranks, styles, and patterns

In Site Builder, you map content to elements by using ranks, styles, and patterns. As you bring 
each source document into Site Builder, you associate a template with the source document in 
the Choose Template dialog box. At the same time, you decide whether to accept the default 
None, which means that neither styles nor patterns will be imported from the source document, 
or to formally select Styles or Patterns.

Styles are the easiest to understand. If your source documents all contain named styles for 
headings and other content, Site Builder will faithfully create an element for each style. If, on 
the other hand, they are manually formatted (all the content is in a single style even though the 
title may be 16 point Arial bold, the first-level headings 12 point Arial italic, and so on), it may 
be best to import patterns.

Problems can arise where documents, whether styled or manually formatted, are inconsistent in 
their treatment of content. Even greater difficulty can occur if you try to associate the same 
template with a mixture of styled and manually formatted documents (and try to import styles 
in one case and patterns in the other). In fact, a warning message will appear onscreen. That’s 
because patterns take precedence over styles. So if you have both a pattern and a style that 
match a portion of content, the formatting instructions in the pattern will prevail. 

That’s where ranks come in. Ranks are ideal for handling source documents that are 
inconsistently formatted, and therefore are especially useful where your project contains one or 
more Directory Items (see Lesson 16). Unlike styles and patterns, ranks are not imported from 
source documents. Rather, Site Builder applies them at translation time. Let’s take a look at a 
simple project to see how all this works.

 1.  Open Ranks1.tcp from the ..\Stellent Content Publisher\Samples\en directory. The 
Contents pane is empty because we have yet to add source documents to this project.

 2.  Click Add Document on the toolbar ( ) and select Page Navigation.doc from the 
..\Stellent Content Publisher\Samples\en\Styled folder. 
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Figure 9-1  The Elements tab dialog for Page Navigation.doc when it is added to the project 
with the default setting None in the Choose Template dialog box.

 3.  When the Choose Template dialog box opens, make sure that None is selected under 
Import Styles or Patterns. Select the template Account and click OK.

 4.  Select the document in the Contents pane and click Element Setup ( ). Click each 
tab, in turn, to see the initial setup. Figure 9-1 shows the Elements tab dialog.

If you tab through the property sheet, you will see that the template contains four ranks, no 
styles, three character patterns, and one metadata (Keywords). These are reflected in the list of 
Elements on the first tab. The ranks, patterns, and metadata are there by default. They appear in 
all general-purpose templates and can be used or ignored as you please. (See Appendix B, 
“Templates and Graphics Sets,” in the Getting Started manual.) In this case, since you are not 
importing styles or patterns, you would want to use the ranks to format your Web pages. Notice 
that the four ranks (see Ranks tab dialog) are mapped to the elements Title, Heading 1, and 
Default Paragraph, which are listed in the Elements tab dialog (Default Paragraph is a default 
element that appears in all templates). 

Let’s try something else.

 1.  Click OK to leave the Element Setup dialog box. 

 2.  Click Add Document on the toolbar ( ) and again select Page Navigation.doc from 
the ..\Stellent Content Publisher\Samples\en\Styled folder.

 3.  This time, when the Choose Template dialog box opens, select Styles under Import Styles 
or Patterns, select the template Analysis, and click OK.

 4.  In the Contents pane, select the second instance of the source document (the one 

associated with the template Analysis) and click Element Setup ( ). Tab through the 
property sheet to see this setup. The elements list (Figure 9-2) is slightly different this 
time.

Although Site Builder imported five new styles, there are only three new elements. That’s 
because, thanks to the default ranks, there already is an element set up for Title and another for 
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Heading 1. But if you wanted to use styles to format, that would be okay. Since styles take 
precedence over ranks, you can simply ignore the ranks.

Let’s try this one more time.

 1.  Click OK to leave the Element Setup dialog box. 

 2.  Click Add Document on the toolbar ( ) and again select Page Navigation.doc.

 3.  This time, in the Choose Template dialog box, select Patterns under Import Styles or 
Patterns, select the template Business, and click OK.

 4.  In the Contents pane, select the newest instance of the source document and click 

Element Setup ( ). Tab through the property sheet and note, in particular, the list of 
patterns in the Patterns tab dialog. Figure 9-3 shows the elements in this template.

Figure 9-2  The Elements list reflects the addition of imported styles: Heading 2, Intro, and 
Normal.
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Figure 9-3  Heading 2 is the only new element in this case because the elements for the other 
patterns that Site Builder created already existed.

When compared with Figure 9-1 (for that template, neither styles nor patterns were imported), 
we see only one new element: Heading 2. That’s from the new pattern of that name. Site 
Builder recognized five patterns in the source document (see the Patterns tab dialog). But 
elements for Title and Heading 1 already existed (thanks to ranks of those names), and two of 
the patterns have been mapped to Default Paragraph. 

Just as styles take precedence over ranks, patterns do, too. In this instance, you could again 
ignore ranks, this time using only patterns to format the Web pages. (Since the patterns are 
distinct — see the descriptions at the bottom of the tab dialog as you select each one — you 
could immediately create unique element names for the ones currently mapped to Default 
Paragraph.)

Try the following. First, select each of the templates, in turn, and click Edit Template. Pass 
your cursor slowly over the Preview window to see which elements apply to the source 
document in each case (a tooltip will display each element name as you do this). This will give 
you an appreciation of how your formatting options differ between the three templates because 
of the way in which ranks, styles, and patterns have been handled.

Second, translate the project. But wait. As things stand, you have three source documents all 
with the same name in your publication. If you click Translate, Site Builder will translate each 
source document, in turn, using the output names specified (by default, the output file name is 
based on the input file name). Try it, if you like. You’ll end up with output for only one of the 
source documents — the last one that Site Builder translates (the one associated with the 
Business template).

To get round this problem, you can do one of two things:

! Change the names of two of the output files. In the Contents pane, click on the output file 
twice, with a pause between clicks, and then rename the output file.

! Assign the output files to unique output directories. Right-click the first source document 
and choose Properties from the popup menu. Under Output Directories, enter “Version 1” 
in the Pages text box. Do the same for the other two source documents (entering “Version 
2” and “Version 3,” respectively). 
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As you navigate through each version of the source document you will see differences due to 
the templates used. You will also see how Site Builder has successfully translated each version 
of the source document to create acceptable Web pages. 

Summary

The keys to successfully formatting Web pages are to recognize that

! Content differences should shape your project setup strategy 

! Ranks, styles, and patterns can all be used judiciously, depending on what you’re trying to 
accomplish 

! Patterns take precedence over styles, and styles take precedence over ranks

! Site Builder imports styles and patterns from the source documents, but it assigns ranks at 
translation time

So when should you use ranks, styles, and patterns? 

! Use only styles where all source documents are not only styled but consistently styled. 

! Use only patterns where all source documents are not only manually formatted but 
consistently manually formatted.

! Use ranks whenever you have a mixture of source documents

The above are not absolutes. For example, styles can work if, say, the style Heading 1 is 
consistently used as a first-level heading throughout the source documents, even if its 
formatting varies between documents. After all, the beauty of being able to map content to 
elements is that you can then format a single element to ensure that the varied content 
associated with that element throughout all source documents is treated consistently in the Web 
pages you create. 

But if, say, the style Heading 1 is used like a title in one source document but as a first-level 
heading in another, problems will quickly arise. In the case of patterns, Site Builder will simply 
generate too many patterns and you will have to spend a great deal of time mapping content to 
elements.The beauty of ranks is that you improve your chances of being able to treat top-level 
content (Title and Heading 1) in a consistent manner. If the goal is simply to translate a mass of 
source documents and apply a basic look, then ranks — pretty much as default — will be fine 
as is. The key point to bear in mind is that there are only two elements you can format: Title 
and Heading 1. Which raises a second question: once you have added documents to a project, 
what next? What do you do after the basic setup is in place? 

Click OK to leave the Element Setup dialog box. Open Ranks2.tcp (Site Builder will prompt 
you to save Ranks1.tcp). Your Contents pane should look like what you see in Figure 9-4. 

That is, the project contains five styled and two formatted documents from the ..\Stellent 
Content Publisher\Samples\en directory. The documents are all associated with the Business 
template. And all were brought into the project with the default None setting turned on in the 
Choose Template dialog box.

Figure 9-4  The Contents of the root publication for Ranks2.tcp. 
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Select one of the source documents and click Element Setup ( ). (It doesn’t matter which 
document, since they all share the same template.) Tab through the property sheet and note 
what you have. What you have, in fact, is the same as what you had when you imported the 
first document into Ranks1.tcp: four default ranks, no styles, three default patterns, and one 
default metadata. That is, the contents of the Elements tab dialog are exactly as in Figure 9-1. 
In fact, the Elements tab dialog is exactly how you would see it no matter how many source 
documents you added to the project, as long as None is the default in Choose Templates.

Translate and view the project. Again, see how, with the default translation by Site Builder, you 
have a good basic setup for your Web pages. But what is next? The problem is, you have only 
two elements you can format: Title and Heading 1. Everything else is mapped to Default 
Paragraph. (If you format Default Paragraph, the variety of content currently mapped to this 
element will suddenly all look the same.) 

If you want to create a more sophisticated, flexible template, you must create additional ranks, 
and possibly also patterns. Patterns can make sense when you have special content such as a 
bulleted or numbered list that is unique in its formatting.

Tips

 1.  When you first start Site Builder, the default setting under Import Styles or Patterns in the 
Choose Template dialog box is None. If you change this setting, it will stay changed for 
all projects until you change it again. So if your source documents are always styled, for 
example, select Styles and Site Builder will import styles each time you add a source 
document to a project.

 2.  All general-purpose templates in Site Builder include three character patterns and the 
Keywords metadata. The character patterns (HTTP, WWW, and Email) are designed to 
ensure that any http://, www, or mailto: links in your source documents are automatically 
linked whenever you create output pages. 
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LESSON 10

Managing Templates

Site Builder ships with a set of default templates as well as some starter templates for your 
projects. (See Appendix B, “Templates and Graphics Sets,” in the Getting Started manual.) 
You have complete flexibility in how you use these templates and create others. As you create 
projects, you’re likely to use a growing number of templates, and the need to manage your 
templates will grow. 

To begin, here are some pointers:

! Each time you start Site Builder with an empty project, a copy of the default project file, 
Default.tcp, is open. This contains a master set of templates available for each new 
project. 

! Site Builder provides four types of template: body page, reference, index, and query. 
Most of the starter templates consist of a template of each type (for example, 
Administration, Administration TOC, Administration Index, and Administration Query). 

! Apart from Blank template, each template in Site Builder, including the default template, 
has certain settings in place. You can modify these settings any way you want, including 
by switching graphics Sets between templates.

! You can easily create new templates based on existing templates (default, starter, or ones 
you have created yourself).

! You can switch graphics Sets between templates with ease.

! You can easily rename templates (it’s best to do this in the Manage Templates dialog 
box).

! You can create a standalone template to create a template file and place it anywhere on 
your network; any other user can then import that template by using the Import command 
in Manage Templates or link to that template.

! Blank is the default body template on which all other body templates are based. There are 
also default reference and index templates (not listed in the Manage Templates dialog box 
unless used in a project), which have certain default settings to ensure they function 
properly.

The keys to template management are

! Creating any new templates you need 

! Updating and tracking them 

! Sharing them with others

Although you created a new template in Lesson 3 of the “Seven Easy Lessons,” we will begin 
this lesson by quickly going through this simple process again in order to demonstrate a point 
later in the lesson. In addition, you will learn how to

! Export templates

! Import templates 

! Link to an external template 

Create a template 

 1.  Open Templates.tcp from ..\Stellent Content Publisher\Samples\en. 
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 2.  Click Manage Templates ( ) to open that dialog box and review the current template 
list. See Figure 10-1. 

This list confirms the current associations in the project (each of the four source 
documents happens to be associated with a different template). Since Template.tcp is 
based on the default project file, it shows the master set of templates available in the 
default project file.

 3.  In the Manage Templates dialog box, click New to open the New Template dialog box. 
Name the new template Archive New and base it on Archive CSS. Accept the default 
setting to create a body template.

 4.  Click OK to return to the Manage Templates dialog box. 

Creating a new template is that simple. You can name the template, base it on an existing 
template, and select a template type all in the same dialog box.

Figure 10-1  The Manage Templates dialog box, showing all the templates available in Site 
Builder.

Export templates

You could export templates for a number of reasons. You may want to simplify your project 
(and reduce the size of the project file) by exporting templates that simply clutter up the 
template list in Manage Templates. You may want to make a particular template available for 
another project or to another user. Or you may want others to be able to link to the template 
from anywhere on the network.

 1.  Select Archive New and click Export to open the Export Template Format dialog box. 

 2.  Select Binary from the list of formats, and click OK to open the Export Template dialog 
box.

 3.  Use the Save In drop-down box to locate the ..\Stellent Content 
Publisher\Samples\en\Other folder in which to save the exported template. Then click 
Save to create a standalone template file. Site Builder will automatically apply the .ttp 
extension if you don’t specify it. Site Builder will then return you to the Manage 
Templates dialog box, where the original Archive New is still listed. (When you export a 
template, you make a copy of the original, which remains with the project.) 

 4.  With Archive New still selected in the Template list, click Delete.
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 5.  Now click Administration, and click Export to open the Export Template Format dialog 
box. Select Binary from the list of formats, and click OK to open the Export Template 
dialog box. 

 6.  In the Export Template dialog box, rename the template Admin New and click Save to 
save it to the same folder as Archive New. 

 7.  In the Template list, click Analysis twice, with a pause between clicks, and rename the 
template Analysis New. Export this template, also to the same folder. The folder should 
now look as you see in Figure 10-2.

Figure 10-2  Site Builder automatically applies the .ttp extension to all template files you 
create. 

Let’s take stock. You created Archive New in the New Template dialog box, based on Archive 
CSS, and you deleted this template from the project after you exported it. You then created 
Admin New in the Export Template dialog box as you exported a copy of Administration. 
Finally, you created Analysis New in the Manage Template dialog box by renaming Analysis, 
and exported that template, too. (Whenever you export a template, you simply make a copy of 
it. The original is still in Manage Templates, unless you delete it from there.)

Import templates

When you import, several issues arise. As we shall see, the underlying name of the template 
can be one issue. Another might be where the template was created because of the references to 
Gallery graphics the template contains. 

 1.  In the Manage Templates dialog box, click Import to open the Import Template dialog 
box.

 2.  Locate the ..\Stellent Content Publisher\Samples\en\Other folder containing the templates 
you exported. Select Archive New and click Open. Site Builder closes the Import 
Template dialog box and the Template Paths Verification dialog box opens. Each time a 
template is moved, Site Builder verifies the paths of the graphics referenced in the 
template.

 3.  Click OK and Site Builder returns you to the Manage Templates dialog box, where 
Archive New is now listed.
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Figure 10-3  Each time Site Builder imports a template, it verifies the paths of the graphics 
referenced in the template.

This was straightforward. But a couple of things can happen when you import templates that 
you should be aware of.

 1.  Click Import again and select Analysis New. Click OK when the Template Paths 
Verification dialog appears. This time, the Manage Templates dialog box doesn’t open 
immediately. Instead, the Template Name Conflict dialog box opens, as shown in 
Figure 10-4. 

 2.  Click Overwrite existing template, and then click OK. Once again you are returned to 
the Manage Templates dialog box.

 3.  Click Import again, and this time select Admin New. Once again the Template Name 
Conflict dialog box appears. See Figure 10-4.

Figure 10-4  The name shown in the Template Name text box is the underlying template name, 
which may be different from the template file name. 

Note the name in the Template Name text box: Administration, not Admin New. When 
you renamed the template as you exported it, you did so in the Export Template dialog 
box. In effect, you named the template file. But the underlying template name of 
“Administration” remained associated with the template and that’s what Site Builder 
recognizes when you import it. If the project no longer contained the Administration 
template, you would be able to import Admin New without this dialog box appearing — 
but the template name in the Template list in Manage Templates would be 
“Administration,” not “Admin New.”

 4.  Accept the name Administration and click Overwrite existing template.
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Link to an external template

In Site Builder, templates typically are internal — in effect, they are saved as part of the project 
file and you never see any physical evidence of them, except in the various formatting and 
other settings. As you have seen, you can easily export a template to create a standalone 
template file. You can also import such a file. 

Another option is to link to an external, standalone file. This can be especially helpful if you 
want to make the same template available to a group of content authors while also controlling 
the use of that template. This is possible because you can create a link to a standalone template 
and use it just like any other — except that it has to be imported into a project in order to edit it. 

 1.  With Templates.tcp still open in Site Builder, click Manage Templates ( ) to open 
the Manage Templates dialog box once again.  

Figure 10-5  Clicking Link in the Manage Templates dialog box opens the Link Template dialog 
box. Any template opened from this dialog will become a linked template in the project. Its path 
will display in the Location column of Manage Templates. 

 2.  Click the Link button top open the Link Template dialog box. See Figure 10-5. (As you 
can see, the Import, Export, and Link Template dialog boxes are essentially the same, 
except for a title bar change.) 

 3.  Once again locate the ..\Stellent Content Publisher\Samples\en\Other folder. Select 
LinkedTemplate.ttp and click Open. You’ll return to the Manage Template dialog box, 
where the template is now listed, with the Location column showing the path and name of 
the linked template. (You may have to widen the Location column in order to see the full 
path and template name.)

 4.  Click OK to return to the main window. 

 5.  In the Contents pane, select one of the source documents and click Choose Template 

( ) on the toolbar to open that dialog box.

 6.  Associate the source document with LinkedTemplate and click OK to return to the main 
window.

 7.  In the Contents pane, select the source document associated with the linked template and 
note the result.

Except for the Choose Template and Manage Templates commands, the Template toolbar 
is not available. That’s because you cannot edit a linked template while it is linked — the 
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template must be formally imported into a Site Builder project in order to edit it. An 
advantage of a linked template is that two or more content creators can consistently apply 
the same template while not being able to change it, thus making it easier to maintain 
publishing standards. 

Figure 10-6  When the source document Publishing Process.doc is associated with the linked 
template “LinkedTemplate,” only the Choose Template and Manage Templates commands are 
available on the Template toolbar.

Tips

 1.  Project files can become quite large. You might want to edit the Default.tcp by either 
deleting unwanted templates from the default project file or “parking” them until you 
need them – that is, export the unwanted templates until you’re ready to use them. See 
Chapter 1 of the Getting Started manual to learn how to edit the default project file.

 2.  You might also want to edit the default project file by modifying the Blank template. This 
template contains few settings and is ideal when you simply want to “pass through” 
source documents to see how they will look without any special formatting. But you 
could, if you like, associate a graphics Set with the Blank template so that each new 
template you create already has the Set associated with it. Again, see editing the default 
project file. 

 3.  There are four types of template: body, reference, index, and query. Although you can 
create a Table of Contents (TOC), List of Tables (LOT), and List of Figures (LOF), you 
are actually using the same default template in each case.

 4.  A “CSS template” is simply one with CSS (Cascading Style Sheets) turned on. You can, 
of course, use a non-CSS template from the starter list and simply turn on CSS. Likewise, 
if you choose a CSS template, you can always turn off CSS.

 5.  As you create new templates, rename existing ones, and edit the default project file, you 
might want to give some thought to template names. 

 6.  This lesson (like the others in the Tutorial) discusses only Default.tcp, the default project 
file used to create HTML projects. You can also create WML projects (to generate WML 
output that can be published to a WAP server and accessed via an Internet-ready device). 
To create WML projects, you use a second default project file: DefaultWML.tcp. See 
“Creating a WML project,” a PDF file in the Documentation folder, for more 
information.
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LESSON 11

Using Metadata

Metadata is simply “data about data.” Many source documents have a number of properties 
separate from the content of the documents themselves. Typically, these can be viewed in the 
Properties dialog box of the application. Such metadata can include the document’s title and 
author, the type and size of the file, the date the document was created, and keywords. Some 
properties are automatically generated by the application when you create the document. 
Typically, you can also create additional, custom properties at any time to suit your 
organization’s needs. 

Just as you can include metadata in, for example, the header or footer of a source document, so 
in Site Builder you can include metadata in the Meta tag of body pages and also display it in 
the output Web pages. Site Builder even lets you include the content associated with any 
element in the Meta tag in this fashion. So when properly handled, metadata can become a 
useful part of your Web publication, making it easy for users to search your Web site. 

Note: This lesson deals only with the properties of a source document as described above. 
However, metadata also refers to those properties you formally assign to a document when you 
check that document into Content Server. For more information on this type of metadata 
(which we call “content server” metadata) and how it might be assigned to your Web pages, see 
online Help.

In this lesson, you will

! Create a new metadata

! Include both the new metadata and the default Keywords metadata in the Meta tag of a 
body page

! Include the Heading 1 element in the Meta tag

Create a new metadata 

 1.  Open Metadata.tcp from the ..\Stellent Content Publisher\Samples\en subdirectory.

 2.  Select either of the two source documents (they are both associated with the same 

template) and click Element Setup on the toolbar ( ).

 3.  Click Metadata to open that tab dialog. Note that the default metadata named Keywords 
already exists (it is included in the starter templates that ship with Site Builder). Select 
Keywords and click Properties. See Figure 11-1.

Note that the Keywords metadata is a standard metadata (as opposed to custom) and is 
mapped to its own element, Keywords. 

 4.  Click Cancel to leave the Metadata Properties dialog box.

The Metadata tab dialog is where you organize the metadata you want to add to your Web 
publication. Keywords already exists in this template. Let’s create a new metadata.
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Figure 11-1  The Metadata tab dialog with the Metadata Properties dialog box on top.

 5.  Click the New button to open the New Metadata dialog box. See Figure 11-2.

Note that you have three options: to create new metadata by selecting a standard entry 
from the drop-down list, specify a custom metadata (see Tips at end of lesson), or specify 
a repository (content server) metadata. Note, also, that the Associated Element text box is 
empty. Using an existing element may be useful in some instances, but typically you will 
want to create a new element for each metadata.

 6.  Accept the default setting Standard and select Author from the drop-down list. 

 7.  Click New opposite Associated Element text box to open the New Element dialog box. 
This is the same dialog box you use to create new elements for ranks, styles, and patterns. 
Here, we’re creating metadata, so the Element Type options are grayed out.

Figure 11-2  The New Metadata dialog box, where you select a name for the metadata you want 
to add to your publication. You also associate the metadata with an element.

 8.  In the Name text box, type Author. Leave the default tag <P> as is.

 9.  Click OK to return to the New Metadata dialog box, where the new element Author is 
selected in the Associated Element text box. See Figure 11-3.

 10.  Click OK to return to Element Setup, and then click Elements to open that tab dialog. 
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The Author element is now listed at the beginning of the Elements list, along with the default 
Keywords metadata. By default, neither is included in the body page. However, both are 
automatically included in the Meta tags of the body pages that will be created when Site 
Builder translates the project. Let’s confirm this.

Figure 11-3  The New Metadata dialog box showing the standard metadata Author created with 
its own element, Author.

 1.  Click OK to return to the main window, and click Translate on the toolbar ( ).

 2.  Click View ( ). (If no source document is selected in the Contents pane, the first one 
listed — Publishing Process — will open.)

 3.  In the browser window, right-click and choose View Source from the popup menu. You 
should see something like Figure 11-4.

Figure 11-4  A view of the HTML output file showing the different information included in Meta 
tags in the Head of the file.

Note that the several Meta tags include the two for metadata: “Keywords” and “Author.” You 
might also want to page through the Web publication and right-click on another page. For 
example, on the opening page of Publishing Process you will see that the metadata changes, 
because the properties of that source document are different.

To confirm that these are the properties of the source documents, return to the Site Builder 
main window and right-click User Interface and choose Open Source Document from the 
popup menu. Then, in Word, choose Properties from the File menu and click Summary to 
open that tab dialog. There, you will see the information that appears in the Meta tags.
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Figure 11-5  By default, metadata are placed in a Meta tag in the Head of output pages.

Include metadata in the Meta tag

Although metadata are included by default in the Meta tags, it’s worth taking a moment to 
review the default settings that ensures this.

 1.  In Element Setup, click Elements to open that tab dialog. 

 2.  Select Keywords and click Properties to open that dialog box.

In the General tab dialog, note that the default setting is to place metadata in a Meta tag in 
the Head of all body pages associated with the template. Note the two other options: to 
include the metadata in the body of the Web pages and also in the page TOC (that is, to 
display in your browser). See Figure 11-5.

 3.  Click Meta Tag to open that tab dialog (see Figure 11-6).

The Metadata name Keywords is already entered in the text box. Note the option to use 
custom tags. These generally aren’t necessary.

 4.  Click OK to return to Element Setup.
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Figure 11-6  The Metadata name is entered by default in the text box Metadata Properties. But 
you can change it, if you want. You can also use custom tags, if you prefer.

Include Heading 1 in Meta tags

 1.  In the Elements tab dialog, select Heading 1 and click Properties. Note the default in the 
General tab dialog. Regular elements are always included by default in the body of the 
output but not in the page TOC or in a Meta tag in the Head.

 2.  Click the Include in Head with Meta tag check box.

 3.  Click Meta Tag to open that tab dialog. In the Metadata Name text box, enter Heading 1. 
This will be used to identify the content in a specific Meta tag.

 4.  Click OK, and OK again.

 5.  Translate and view your Web publication. Again, right-click on the opening page of one 
of the two source documents and view the changes in the Meta tag entries. You should 
now see one that reads

<meta name="Heading 1" content="Using Color">

You can page through the Web publication and view source to see how each Heading 1 
has been picked up in the Head section in this way. 

That was just a brief introduction to metadata. Be sure to read the following.

Tips

 1.  The metadata you can obtain from source documents to include in Meta tags will vary by 
the format of the source document. With some source documents, you may not be able to 
generate metadata at all. Others will let you generate only standard metadata. Only with 
Word, Excel, and PowerPoint (versions 97, 2000, and XP in each case) can you generate 
custom metadata. You need to experiment with source documents to see what can be 
brought into your HTML files.
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 2.  Keep in mind, too, the need to control metadata in the source documents themselves. The 
standard properties of a document may be dated. For example, the properties of a Word 
file include its title and author. But the title may simply be the first word typed in the 
document. Likewise, one person may have been the originator of a document (his or her 
name will be a property) but the document may have been passed to another who may be 
responsible for creating the bulk of the content and for maintaining the document. Also, if 
you create one document by making a copy of another, the new document will inherit the 
properties of the first document. In short, some cleanup of source documents may be in 
order, depending on which properties from those documents you plan to include in the 
Meta tag of your Web pages.

 3.  Not all the metadata in this list are necessarily available from your source documents. 
Again, you need to experiment.

 4.  See online Help (search under “metadata”) for explanations of how you can place content 
server metadata in Web pages and also publish standard and custom metadata to Content 
Server.
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LESSON 12

Creating a More Sophisticated Frameset

In Lesson 1 you created a simple frameset to display a table of contents and a body page. 
Framesets can be more sophisticated. In fact, they can be a powerful tool for organizing the 
content of your source documents and managing the various reference pages you choose to 
create. 

While framesets are potentially complex — the ease of creating framesets in Site Builder is 
tempting — you still must think through the structure of your Web publication so as not to 
overwhelm your users with too many frames and therefore too many competing pages. A 
frameset of no more than four or five frames will suit most purposes. Always try to envision 
how you want your publication to appear onscreen.

In this lesson, you will

! Create a frameset and apply it to three publications

! Add links for navigating between the framesets

! Promote index entries to the top index and eliminate indexes in the subpublications

! Refine the appearance of the TOC in the top frameset

! Add a Print button to the top-level TOC

! Name the framesets to control what displays in the browser title bar

Create a frameset 

 1.  Open Frameset.tcp, which consists of a root publication and two subpublications. The 
root publication contains a TOC, an index, and a single source document (First Page.doc). 
Each of the subpublications contains a TOC, an index, and two or three source 
documents. 

 2.  Click Translate ( ).

 3.  In the Publication Hierarchy pane, select the root publication and click anywhere in the 
Contents pane so that nothing is selected there. 

The project doesn’t contain any framesets yet. By selecting no output page in the 
Contents pane, you ensure that the browser will open the 
first page — the TOC for the root publication.

 4.  Click View ( ). The opening page is as shown in Figure 12-1.

While all your content has been gathered together in the project, framesets are not yet 
being used to properly structure it. The only links between the root TOC and the rest of 
the publication are via entries in the TOC (Site Builder creates these links automatically 
when it builds the reference page). Also, the browser title bar displays the title of the root 
publication (which you can confirm by opening the Publication Properties dialog box and 
also by opening the Titles tab dialog of Globals).
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Figure 12-1  With your publication unframed, only one page can be viewed at a time. Also, the 
browser title bar displays the publication title, not the frame title.

In the browser window, click Page Navigation under Subpublication A, to jump to that 
document in Subpublication A (which looks different because of the graphics Set associated 
with the template). But when you click the TOC button on that page, you will jump to the TOC 
for the subpublication — not back to the main TOC. 

Try something else. In the main window of Site Builder, select the root publication, and then 

select Index in the Contents pane and click View ( ). An error message will appear. There 
are index entries in the indexes of the two subpublications (open them and see), but the content 
has not yet been promoted to the top index. 

So we have several tasks before us.

 1.  Click Layout on the toolbar ( ) to open the Layout dialog box. 

 2.  Under Active Layout, select Frameset Layout. See Figure 12-2.

Figure 12-2  The Layout dialog box, with the publication hierarchy displayed in the 
Publication Hierarchy box at the top-left. When you first enter the dialog box, you may have to 
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click the scrollbar at the bottom of the box in order to display the plus sign, which you can click 
to display the subpublications.

 3.  In the Publication Hierarchy box at the top left, select Creating a more sophisticated 
frameset if the root publication isn’t already selected. Click the New Vertical button to 
create two frames: trFrame1 and trFrame2. Both frames are immediately populated: the 
first with the TOC icon, and the second with the Body Pages and Index icons. When you 
create a frameset, Body Pages is automatically added to one of the frames. The TOC and 
Index icons have been assigned here because these reference pages already exist in the 
publication. 

 4.  With your mouse, drag the Index icon from trFrame2 and drop it into trFrame1. Now the 
TOC and Index are assigned to the same frame. That’s fine, because we’re going to create 
a frame in which you can toggle between these two reference pages. Since the TOC is 
listed first here, it will open first in your browser.

 5.  In the Publication Hierarchy box, click the scrollbar at the bottom, if necessary, to reveal 
the plus box for the root publication, and click the plus sign to display the 
subpublications. Select each subpublication, in turn, and note that neither currently has a 
frameset. That’s easy to fix. 

 6.  Right-click the root publication and choose Copy from the popup menu. Then select one 
of the subpublications and right-click again. This time choose Paste Special from the 
popup menu, and on the submenu click All publications in the project. The 
subpublication now has the same frameset as the root publication. Click the other 
subpublication in the Publication Hierarchy box and you’ll see that it, too, has the same 
frameset. 

 7.  Click OK to save your changes in the Layout dialog box and return to the main window. 
Click Translate and then View and see what you’ve accomplished. 

You’ve created a simple frameset for your root publication and applied it to the two 
subpublications. Populating the framesets was easy, thanks to default settings in Content 
Publisher. But there are still navigation problems. 

Figure 12-3  Here is a simple frameset with two frames. Note that the browser title bar now 
displays the title of the frame — the default “FrameTitle.” The main page displays a TOC 
button at the top of the page and a Top of Page button at the bottom, thanks to default settings 
in the template. It will display an Index button once the index is built.
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Add links for navigating between the framesets

Remember: you want to be able to toggle between the TOC and Index in the first frame at the 
top level of the publication. To create the Index, you must promote index entries from the 
source documents in the two subpublications. Once you do that, you can eliminate the two 
indexes at the subpublication level.

 1.  In the Publication Hierarchy, select the root publication Creating a more sophisticated 

frameset, and then select the TOC in the Contents pane. Click Navigation ( ).

 2.  Under Link Type, opposite Index, double-click in the Before column to place an Index 
button in the TOC (note that the icon from the graphics Set associated with the template 
appears in the preview window below). Under alignment, select Center. Click OK.

 3.  Now select the Index in the Contents pane and click Navigation ( ). This time, 
double-click opposite Table of Contents in the Before column to add a TOC button to the 
Index. Center this button, too. Click OK.

You have created the necessary buttons to toggle between the TOC and Index. But if you were 
to translate and view the publication now, the Index button still wouldn’t appear on the TOC 
because the Index still doesn’t exist. (Site Builder doesn’t create output HTML files for empty 
reference pages.)

Populate the top-level index and eliminate the sublevel indexes

Let’s populate the top-level index.

 1.  In the Publication Hierarchy pane, select one of the subpublications (it doesn’t matter 
which one, since both are associated with the same template). In the Contents pane, select 

the Index and click Element Setup ( ).

 2.  In the Elements tab dialog, note that the Promote As column is empty (except for the 
default promotion of the Title (System) element as Title). Double-click in the Promote As 
column opposite Index Entry and Index SubEntry, in turn. (These are special Index 
elements created for every index you build.) 

You have promoted each of these elements. Normally, you would have to go to the top-
level reference page and formally include the elements there. However, since these 
elements exist by default in all Index reference pages, you don’t need to do anything. 

 3.  Still in the Elements tab dialog, in the In Body column, double-click opposite those same 
elements — you have now removed those entries from the indexes of the subpublications. 
Once you save these changes, these indexes will be empty and won’t display in your Web 
publication. Figure 12-4 shows how the elements list should look once you’re done.
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Figure 12-4  Element Setup for the template used for the indexes of the subpublications. Note 
that, for an index reference template, only the Elements tab dialog is available.

 4.  Click OK to return to the main window. Then click Translate again, select the main 
TOC, and click View. 

Since the index now exists, the Index button is now on the TOC (the button can also be 
seen in the main frame). You can confirm this by clicking the Index button. See 
Figure 12-5.

Figure 12-5  The top-level index, showing index entries from documents in the subpublications.

 5.  The Index has a TOC button, which you added. Click it and you will return to the main 
TOC. So you can now toggle between the two reference pages. 

 6.  Click one of the entries on the TOC and you will go to that document in one of the 
subpublications. Note that clicking the TOC button on the TOC of one of the 
subpublications takes you back to the top-level TOC. 
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Refine the appearance of the top-level TOC

With our basic navigation now in place, let’s improve the appearance of the top-level TOC.

 1.  Click Layout ( ) to open that dialog box. With the root publication selected in the 
Publication Hierarchy box, double-click the trFrame1 frame, containing the TOC and 
Index icons, to open the Frame Properties dialog box for that frame. (You can also right-
click and choose Properties from the popup menu.) 

 2.  In the General tab dialog, under Options, clear the Borders and Sizable check boxes. 
Then click OK to return to Frame Layout.

 3.  Double-click trFrame2, and in the Properties dialog box for this frame also clear the 
Borders and Sizable options. 

When two frames are adjacent, the three options in the General tab dialog (Borders, 
Sizable, and Scrollable) should be set the same way for both frames. 

 4.  Click OK to leave the Frame Properties dialog box, and OK again to return to the main 
window.

 5.  In the Publication Hierarchy pane, select the root publication, and then the TOC in the 

Contents pane. Click Edit Template ( ) on the standard toolbar to open the Edit 
Template dialog box.

 6.  Pass your cursor over the Preview window to confirm the elements in use. 

 7.  Click Element Setup, and in the Elements tab dialog, double-click in the In Body column 
opposite Title. Click OK to return to the Edit Template. The Title element is now gone.

This, as we shall see, is just one simple way to clean up the appearance of the main TOC. 
The use of CSS options will help, too.

 8.  Click Globals, and then click Options to open that tab dialog. Click Allow CSS 
character and paragraph formatting. (Note the more limited set of options available in 
Globals when a reference page is selected.) Click OK to return to the Edit Template 
dialog box. Pass your cursor over the Preview window to confirm that the two elements 
you need to format are Title (System) and Heading 1.

 9.  Click Formatting. The Character tab dialog is open by default. Select Title (System) 
from the Elements list and change the font, size, alignment, and color. 

In the Character tab dialog, choose Arial Black (or another strong font that is on your 
machine) from the drop-down list under Font Name. Under Font Size, click Use this size 
and select Custom from the drop-down list. Select the default size of 10.00 points and 
type 12, to change the font size to 12 points.

Click the Color button and select red from the Color dialog box. Click OK to return to 
Formatting. Click Paragraph to open that tab dialog, and under Alignment, click Use 
this alignment and select Center from the drop-down list. 

 10.  Now select Heading 1 from the Elements list in Formatting and format that, too.

In the Character tab dialog, choose Arial from the drop-down font list. Under Font Size, 
click Use this size and select Custom from the drop-down list. Accept the default size of 
10.00 points that appears below. Click Effects to open the Effects dialog box, and select 
Always On from the Bold drop-down list.

Click the Color button and select a dark gray from the Color dialog box. Click OK to 
return to Formatting. Click Lists and under Type click Bulleted List. Then click the 
Bullet button and select bevmablt.gif from Bullets group in the Gallery. Finally, make 
sure that the check box Strip input to first blank space or tab is clear (since there are no 
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bullets already associated with this style, selecting this box would strip the first word of 
each heading). Then click OK to return to Edit Template. 

Figure 12-6  The Edit Template dialog box, which is adjustable. When viewing pages with a 
great deal of content, you might want to click the Maximize button on the title bar so that the 
dialog box fills your monitor screen. 

 11.  Click OK to return to the main window. With TOC still selected, click Globals. Open the 
Separators tab dialog and clear the two check boxes for separators before and after. (The 
separators are default settings for the template.) Click OK to return to the main window. 
See Figure 12-6.

 12.  Select First Page.doc and click Globals again. Click Colors. Under Background Colors, 
clear the Use a background graphic check box (another default setting) and click 
Background. Then click the Color button and choose white from the Color dialog box. 
Click OK to return to the Color tab dialog in Globals. 

Figure 12-7  The top-level TOC after formatting with CSS turned on. You could format the main 
frame to make its appearance compatible with the TOC.

 13.  Translate again, and the top level of your Web publication should look like what you see 
in Figure 12-7.
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Add a print button

Site Builder’s print functionality is especially powerful when you are using Internet Explorer. 
With this browser, you can print all or selected portions of a Web publication, no matter how 
large the publication. (With Netscape Navigator, any Print button you add will function in the 
same way as the Print button on the browser toolbar.)

 1.  In the Publication Hierarchy pane, select the root publication, and then in the Contents 

pane, select the top-level TOC. Click Navigation on the toolbar ( ).

 2.  In the Page Button Bar tab dialog, under Link Type, select Print and then double-click in 
the Before column. The following warning will appear onscreen:

In any new project, this functionality is automatically turned on by default and you 
wouldn’t get this warning. In fact, the functionality is so simple that when you’ve added 
the Print button in Navigation, you’re done. The functionality has been intentionally 
turned off here so that we can review the settings for this to work. 

Note: Though it won’t work just yet, the Print button has been added to the TOC. Click 
OK on this warning dialog box, and OK again to return to the main window.

 3.  From the View menu, click Project Options to open that dialog box. Click Map File / 
Print Publication to open that tab dialog. See Figure 12-8.
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Figure 12-8  The Project Options dialog box, which you open from the View menu. You need to 
specify both a Map file and a script to enable the print functionality. 

 4.  Under Map File, click Create XML Map file. If the default Map file name MapFile.xml 
isn’t already entered in the text box, type the name (or another name) for the file. Site 
Builder won’t generate this file unless you provide a name for it. But it will add the .xml 
extension if you don’t.

 5.  Under Print Publication, click Gallery to open the ..\Stellent Content 
Publisher\Gallery\en, with the HTML Code subdirectory already open. Select 
PrintPublication.htm and click OK to return to the Project Options dialog box. The path 
and name of the file now appear in the File Name text box.

 6.  Click OK to return to the main window.

You have now completed the three steps necessary to enable the print functionality for 
your project: instructed Site Builder to generate an XML Map file, provided a name for 
the file, and selected a script that will obtain a necessary control from the Web site (see 
Tips for more information).

 7.  Click Translate and then View. Note that the Print button now appears on the top-level 
TOC frame.

 8.  Click Print. 

If you are using the Print functionality for the first time on your machine, this will 
activate the script in PrintPublication.htm, with instructions to obtain a file from the Web 
site. Click OK if a browser security warning should appear onscreen. Shortly, the print 
functionality will be enabled and the Select Files to Print dialog box will open. See 
Figure 12-9.
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Figure 12-9  The Select Files to Print dialog box, when it first opens. 

 9.  Select the files you want to print and click OK. 

When the Select Files to Print dialog box first opens, the complete hierarchy of the 
publication is visible but no files are selected for printing. Clicking a top-level box 
(publication) automatically selects for printing all files below that level. But you can clear 
any boxes at the sublevels to deselect a file. In this way, you can, in fact, print any 
combination of files that you want.

Before leaving the dialog box, scroll down to the end of the list of files and notice the last 
item: “Creating a Web publication with framesets.” This entry is for the source document 
FirstPage.doc. Where did this title come from? You may want to read Tip 7, at the end of 
the lesson, before closing the Select Files to Print dialog box.

Name a frameset

When you create framesets for a publication, any instructions set in the Titles tab dialog of 
Globals for the browser title bar are no longer relevant. As we saw in Figure 12-3, what will 
appear, instead, is the name of the frameset.

 1.  In the main window, with the root publication selected in the Publication Hierarchy pane, 

click Layout on the toolbar ( ).

 2.  Under Active Layout, select Frame Layout, and click the Frameset Properties button.

 3.  In the Frameset Title text box, type Creating a more sophisticated frameset.

 4.  Click OK, and OK again to return to the main window.

 5.  Click Translate and then View.

Note the new title in the browser title bar of the top frameset. Click one of the entries in 
the TOC, however, to jump to a frameset for one of the subpublications and “FrameTitle” 
will once again appear.

A couple of thoughts before we wrap up. If you wanted the title “Creating a more sophisticated 
frameset” to appear in the browser title bar for all framesets, this would be easy for this 
particular project. Since the two subpublications mirror the root publication in frameset 
structure and the content of the frames, you could use the Copy and Paste Special commands 
in Frame Layout to copy the revised frameset property into the other two framesets. If you 
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leave the Frameset Title text box empty (step 3, above), the browser will display the path and 
name of the frameset file (Frame.htm, by default).

Tips

 1.  How you structure content in the Contents pane is simply a means to an end. It’s 
important to envision how you want your Web publication to look like when you’re done.

 2.  In this lesson, for example, we used reference pages to pass elements (and therefore 
content) from a lower level to the top level. The indexes remained in the project but were 
not published, because Site Builder does not create empty output pages. (Lesson 17 goes 
into this in more detail.) 

 3.  As another example, we got rid of the individual source document titles for the top TOC. 
You wouldn’t always want to do this, especially if your publication is complex. But here 
we were able to simplify the look of the TOC.

 4.  You might want to review the output directories in Windows Explorer. The root 
publication uses C:\Program Files\Stellent Content Publisher\Output\Lesson 12 (unless 
you changed it), which Site Builder created when you first translated the publication. In 
addition, Site Builder created two subdirectories (..\Lesson 12\SubpublicationA and 
..\Lesson 12\SubpublicationB), thanks to the subpublication name in each case also being 
used for the output name. You don’t have to recreate the complete path in the Publication 
Properties dialog box. Site Builder simply mirrors the publication hierarchy on the output 
side, using the names of folders you designate at the subpublication level. This can be 
handy if you choose to change the output directory. You have to change it in only one 
place: Publication Properties for the root publication.

 5.  You didn’t do it for this lesson, but you can, of course, adjust the size of frames in a 
frameset very easily with your cursor. You can also open the Frame Properties dialog 
boxes (select a frame and click the Frame Properties button) for a more precise 
measurement.

 6.  The Print functionality is typically enabled in Site Builder. If for some reason it isn’t, you 
saw how a few quick changes in the Project Options dialog box will take care of things. 
When you use the Print button the first time, Site Builder runs the script to download and 
install a print control required to enable print functionality. For more information, see 
online Help. (For example, select the entry “print functionality” from the Index.)

 7.  When the Select Files to Print dialog box opens, what you see reflects the contents of the 
XML Map file, which Site Builder generated when you translated the project. In creating 
entries for the Map file, Site Builder uses the titles of the different components of your 
publication as follows:

! Publications — From the publication title, as it appears in the Publication Properties 
dialog box.

! Reference pages — From the title as specified in the Titles tab dialog of Globals. By 
default, this would be the publication component (publication title, as set in the 
Publication Properties dialog box) and the document title (as specified in the Document 
Properties dialog box). For the templates in this project, the publication component was 
turned off (check the Title tab dialog in Globals) and only the document component was 
used.

! Source documents — Site Builder uses the Title element in the document. You can 
confirm this for all source documents in the project by clicking each one and opening the 
Edit Template dialog box. Most of the source documents have a file name that happens to 
be the same as the title in the document. The title in the document was created with the 
Title style. But since documents were added to this project with the default None setting 
in Choose Template, no styles (or patterns) were imported. The Title rank was applied 
instead. Since FirstPage.doc has only a single major heading, Site Builder applied Title to 
that (even though in the source document the heading is in the Heading 1 style).
77



Content Publisher
78



Content Publisher
LESSON 13

Creating Hyperlinks in Web Pages

Much of the navigation in Web publications is directly from reference pages to body 
documents or by means of standard navigation buttons that allow you to scroll from one page 
to the next or return you to a table of contents or index. Such navigation is easy to set up in Site 
Builder because most of these links typically are inserted automatically.

But navigation between and within individual documents can often be desirable, too. Many 
source documents now contain hyperlinks to facilitate movement between source documents. 
Hyperlinks are simpler to create than cross-references and are potentially more powerful. Site 
Builder preserves such links when you translate a project and thus allows for their continued 
use in Web publications. (As you will have noticed, these types of links are used quite a bit in 
the HTML documentation for Site Builder.)

In this lesson, you will review the links that

! Allow jumps between Web pages

! Open target documents in their native format

! Open any Web site anywhere

! Activate the mailto: option so that you can immediately send a message to any pre-
identified addressee

Let’s first review the nature of these links in the original source documents.

Reviewing hyperlinks

 1.  Open Hyperlinks.tcp from the ..\Stellent Content Publisher\Samples\en directory. 

 2.  Right-click Hyperlinks.doc and choose Open Source Document from the popup menu. 

If you are running Word 97, 2000, or XP, the source document will open in its native 
format. Scroll down and note the various hyperlinks already entered in this test document. 
To check any hyperlink, right-click on the link, choose Hyperlink from the popup menu 
and then Edit Hyperlink from the submenu. The Hyperlink dialog box in Word will 
open.

 3.  Close the source document in Word. Click Translate on the toolbar ( ), and then click 

View ( ). See Figure 13-1.
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Figure 13-1  The source document Hyperlinks.doc contains some of the more obvious types of 
hyperlinks you might want to create in your source documents and have preserved in the output 
pages that Site Builder creates.

 4.  Scroll down the main Web page and click each hyperlink, in turn.

Let’s review the different types of links in Hyperlinks.doc.

Note: The behavior of these links may vary between browsers. 

Links A and B are typical links where the source document and the target document are both 
part of the same project. As a result, clicking the source takes the user directly to the Web page 
that was created from the target document. Link B is a little more subtle in that it takes the user 
directly to a specific place (heading) in the target document — thanks to a bookmark that has 
been placed there. If links are successfully created between source documents, Site Builder 
takes care of the rest and ensures that they are preserved in the output HTML pages.

Link C is a little different. Here, since the target document is not part of the project, Site 
Builder will not create a Web page from the document. But it will still preserve the link, if it 
can. This won’t be difficult because the target file has been made an “associated file” in the 
project. Site Builder “passes through” associated files and makes them available on the output 
side. The original file is in C:\Program Files\Stellent Content Publisher\Samples\en\Styled.

Note: If you are using Netscape Navigator, the target file likely will open in Word; if you’re 
using Internet Explorer, it will open in the browser window (with the target document in its 
native format, nonetheless).

Link D shouldn’t work! That is, the target document is not in the project and the link contains 
a relative path that Site Builder can’t find. This type of link (like Link C) is an ideal candidate 
for the “associated file” feature in Site Builder, which we will look at shortly.

Link E is a standard hyperlink to a URL that is easy to set up in your source document and 
which Site Builder preserves without difficulty. You can jump to any URL anywhere, as long 
as the URL is valid.

Link F is also a standard hyperlink, this time designed to open your e-mail program with a 
specified addressee already set up for mailing. This link will only work, however, if your 
browser has an email option associated with it.
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Link to an associated file

Let’s make Link D work. 

The target document for Link D is Other Issues Copy.doc, which resides in the ..\Stellent 
Content Publisher\Samples\en\Other directory. The goal is to place this file in the output 
directory where the output files for Hyperlinks.doc are to be found — namely, C:\Program 
Files\Stellent Content Publisher\Output\Lesson 13. By doing this, your browser will be able to 
find the file and open it.

You could move this file manually, by locating it in Windows Explorer, making a copy, and 
placing that copy in the appropriate output directory. A far better way is to make the file an 
“associated file.” As such, it will become an integral part of the project file and will be 
referenced by it.

 1.  In the main window, click Associated Files  on the standard toolbar to open the 
Associated files dialog box.  

 2.  Click the Add button to open the Open dialog box. Locate and select Other Issues 
Copy.doc in the ..\Stellent Content Publisher\Samples\en\other directory and click Open. 
The file is now listed in the Associated Files dialog box. See Figure 13-2.

 3.  Click OK to close the dialog box. 

 4.  Then select Hyperlinks.doc in the Contents pane and click Globals to open that property 
sheet. Click Options to open that tab dialog, and select Strip path from external 
hyperlinks. 

Figure 13-2  Other Issues Copy.doc has been added to the root publication as an associated 
file. Site Builder will make a copy of the file when you translate and place the copy in the Pages 
output directory.

 5.  Click Translate  and then View . Now try Link D. It should open the Word 
document (in the browser, if you are using Internet Explorer; in Word, if you are using 
Netscape Navigator).

Tips

 1.  You may need to experiment to see what hyperlinks are possible with different types of 
source documents and also different settings for those hyperlinks.

 2.  As you build your projects and use ASP, Java, or graphics files that will eventually reside 
on your Web server, you should make use of the Associated Files feature. In this way, you 
don’t have to remember to copy them to the Web server each time — Site Builder copies 
them to whatever output directories you are using for your translated or published output. 
You can also use the pass-through option for a Directory Item to handle associated files, 
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since that option allows you to pass through files in their native format. For more 
information, see “Passing through source documents without conversion” in the Help 
system.

 3.  If you have an associated file that is referenced by several publications in your project, 
you will have to add it to the Associated Files list for each publication. However, if you 
specify an output directory for Gallery Graphics (in the Publication Properties dialog box 
for the root publication), you can place it in the Gallery Graphics directory when you add 
it to each of the Associated Files lists. That way, only one copy of the file will be made. 
(The Gallery Graphics output directory can be used for any associated files, not just 
graphics.)
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LESSON 14

Creating a Publication Hierarchy

One of the most powerful features of Site Builder is the ability to create a publication hierarchy 
consisting of the root publication plus additional publications at different levels below the root. 
A typical publication hierarchy might look like the one in Figure 14-1. This reflects a particular 
corporate structure, and could very well represent the structure of a proposed Web site. 

Publications can have long names — the more descriptive, the better. A publication, after all, is 
simply a container for the source documents you want to translate. Think of the root 
publication as the title of a conventional book and all the other publications as chapters or 
sections in the book. So the value of the publication hierarchy resides, initially, in your ability 
to structure your Web publications so that the information published on your Web site 
accurately reflects your organization’s structure — or whatever it is you are seeking to 
communicate. 

Figure 14-1  A typical publication hierarchy you might create for your Web site if you were 
seeking to capture organizational structure. You can manipulate individual publications in the 
hierarchy to change their order or the level at which they reside.

Once you have created a publication hierarchy, you are ready to populate each publication with 
the source documents you want to translate. The publication hierarchy — in effect, the 
complete project represented by what you see in the Publication Hierarchy pane plus the source 
documents in each publication in a given order — becomes increasingly important the greater 
the amount of information you seek to publish. This is especially so as you add navigation 
buttons and create reference pages, because this structure determines the potential flow of 
information on your Web site.

Note: The entire publication hierarchy is never visible at any time. While the Publication 
Hierarchy pane displays the hierarchy of publications (in expanded or contracted form), the 
Contents pane displays only the contents of whichever publication in the Publication Hierarchy 
pane is currently selected. 

When you start a new project, you always begin with a root publication. There are several ways 
to add publications to create the publication hierarchy. In this lesson, you will see how easy it is 
to create — and restructure — the hierarchy. In the next lesson, you’ll learn how to add content 
to a publication, using a special feature in Site Builder.
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So in this lesson, you will

! Create a project file

! Add publications to the root publication

! Change the structure of the publication hierarchy

! Move publications between two instances of Site Builder

Note: Much of what you’ll learn in this lesson about manipulating publications in the hierarchy 
is akin to working in Windows Explorer. You can rename, copy, and paste publications in the 
Publication Hierarchy pane just as you can rename, copy, and paste folders in Windows 
Explorer. Unlike Windows Explorer, however, you can decide the order in which the 
publications appear.

Create a project file

 1.  Open Site Builder. 

 2.  In the Publication Hierarchy pane, click “Unnamed” twice, with a pause between clicks. 
In the edit box that appears, type Corporate Site for the name of your new root 
publication. Press Enter.

 3.  From the File menu, choose Save As. In the File Name text box, type Corporate.tcp and 
save the project file in the ..\Stellent Content Publisher\Samples\en subdirectory.

You have created the project Corporate Site and saved it to the project file Corporate.tcp. 

Add publications to the root publication

 1.  You can add publications in several ways. Try all of the following:

! Click Add Publication on the standard toolbar or the large toolbar ( ).

! Choose Publication from the Add menu.

! Right-click Corporate Site in the Publication Hierarchy pane and choose Add and then 
Publication from the popup menu.

In each case, the Add Publication dialog box opens. 

 2.  Type Marketing in the Name text box. Note that the name is automatically inserted in the 
Publication Title text box and also used for both the Pages and Graphics output 
subdirectories. Click OK.

As you can see, Marketing is now a subpublication of Corporate Site, which has acquired a 
“minus box” before it. Click the box to contract the publication hierarchy (and turn the minus 
sign into a plus sign). Click the box again to expand the hierarchy.

 3.  Repeat steps 1 and 2 to add publications named R&D, Operations, and Finance to the 
root publication. Make sure you select Corporate Site each time, or each new publication 
you create will become a subpublication of the previous one created.

 4.  Click Save on the toolbar ( ).

You have now created a simple publication hierarchy for the project Corporate Site, with all the 
subpublications at the same level, immediately below the root publication. And you have saved 
the publication hierarchy in the project file Corporate.tcp.
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Change the structure of the publication hierarchy

With this simple structure, you can easily move publications around, the same way as you do 
folders in Windows Explorer. But Site Builder gives you added flexibility. Let’s say in our 
example you want to move Finance in relation to R&D. 

 1.  Right-click Finance and drag it over R&D. When Finance is highlighted, let go of the 
mouse.

Two things will happen. Finance will revert to its original order in the publication 
hierarchy and a popup menu will appear.

 2.  From the popup menu, choose the appropriate command: Move Before, Move After, or 
Move Into.

 3.  The popup menu disappears and Finance is now before or after R&D in the hierarchy (or 
has become a subpublication of R&D, if you chose Move Into).

That’s how easy it is to move publications in the hierarchy. Remember: you can drag and drop 
source documents in the Contents pane to change the order of those, too.

Like Windows Explorer, you can display and hide a particular level of publications by clicking 
the box to the left of the publication at the next level up. (In this case, only the root publication 
has a box.) Alternatively, you can right-click a publication and choose Tree and then Expand 
All or Contract All from the popup menu. Or you can simply double-click the publication icon 
to expand and contract its contents.

Move publications between two instances of Site Builder

Once you start creating publications in Site Builder, you will probably have occasion to move 
publications between projects. One way is to export a publication from one project and import 
it into another. (In the first project, select the subpublication you want to export, click Export 
Publication on the File menu, and save the subpublication as a project on your file system. In 
the second project, select the root publication or a subpublication, and click Import Publication. 
Once you import the project, it immediately becomes part of the second project.) 

An even simpler way, however, is to have both projects open at the same time in separate 
instances of Site Builder, and then to use the Copy and Paste commands to copy a publication 
from one instance of Site Builder into another. 

Let’s do that. You could open another project file from the Tutorial, but instead:

 1.  Choose Save As from the File menu, and save the project file under the name 
Company.tcp. So you now have two identical project files, with the second one open.

 2.  Change the names of the four existing publications to Communications, Legal, 
Manufacturing, and Accounting. (Left-click each publication twice, with a pause between 
clicks, to rename each publication in the edit box that appears.)

 3.  Click Save ( ) to save Company.tcp.
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 4.  Start a second instance of Site Builder. That is, from the Start menu, choose Programs, 
and then choose Stellent Site Builder from the Stellent Content Publisher program 
group. 

 5.  In the second instance of Site Builder, open Corporate.tcp, the original project file you 
created (it should be in your ..\Stellent Content Publisher\Samples\en directory).

 6.  In the Publication Hierarchy pane of Corporate.tcp, right-click one of the publications 
(say, Marketing), and choose Copy from the popup menu. 

 7.  Move the mouse over the first instance of Site Builder and click the main window to 
activate that instance of the application (or click the appropriate button on the Windows 
taskbar to activate the program).   

 8.  Right-click Communications, and from the popup menu choose Paste.

A copy of the Marketing publication from Corporate.tcp has now been pasted into the 
Communications subpublication of Company.tcp, and so has become a subpublication of 
Communications.

Had you pasted Marketing into Corporate Site, instead, Marketing would have become 
part of the publication hierarchy at the same level as Communications.

Note: When you copy a publication from one project to another, typically the Project Paths 
Verification dialog box will appear. This happens because, in copying a publication, you bring 
information in the project file with the publication, including paths for source documents and 
other files, some of which likely will change. Site Builder must confirm this information before 
copying the publication into the existing project. 

Tips

 1.  A publication hierarchy can be set up very easily in Site Builder, and you can manipulate 
the publications in the hierarchy just as you do folders in Windows Explorer. 

 2.  Your right mouse button will help you quite a bit when you start changing the structure of 
the publication hierarchy, thanks to the special popup menu that appears when 
repositioning publications.

 3.  Copying a subpublication from one project to another can be as easy as in the example 
above, with two instances of Site Builder open. 

 4.  When copying a publication from one project to another, you may encounter a message 
about overwriting templates. This will occur if the project you’re copying a publication 
into uses the same template as the publication being copied — and the two templates are 
not exactly the same. In that event, you will have to rename the specified template you are 
importing. But you can always re-associate a template with the source documents of the 
imported publication afterward.
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LESSON 15

Adding Directory Items

A Directory Item is simply a directory (folder) on your file system that you add to a publication 
in a project. You can specify the file types in the folder to be included in your publication. 
When you use the Update Versions command before translation, Site Builder recognizes new 
documents added to the folder and produces output pages for the current contents of the folder.

You can automate the Update Versions command. As a result, once you identify the directory 
and file types, you can drop files of the specified types into that directory at any time and they 
will be included in the next translation. The Directory Item may be especially useful where 
content providers throughout an organization are charged with periodically handing off revised 
source documents to be translated at a scheduled time each week, say. 

You can, in fact, add a Directory Item in one of two ways. You can

! Add a single Directory Item by using the Directory Item command on the Add menu

! Add several Directory Items at the same time by using the Folder Import wizard that lets 
you add a portion of your file system to your publication hierarchy (see Tip 4)

In this lesson, you will

! Add a single Directory Item to a project

! Set translation options for that Directory Item

! Use the Folder Import wizard to import a portion of the file system 

Note: You can also add a dynamic Directory Item to a publication. See “Creating a dynamic 
Directory Item,” at the end of this lesson.

Add a single Directory Item to a project

 1.  Open Corporate.tcp, the project file you created in lesson 14. (If Company.tcp is still 
open in a second instance of Site Builder, close that instance of the application.)

 2.  In the Publication Hierarchy pane, select Marketing, and then choose Directory Item 
from the Add menu, to open the New Directory Item Properties dialog box (see 
Figure 15-1). 

The Directory Item command is also available from the popup menu that appears when 
you right-click a publication in the Publication Hierarchy pane. 
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Figure 15-1  The New Directory Item Properties dialog box. You must choose a template for the 
source documents in the specified directory before you can leave this dialog box. The Options 
tab dialog lets you refine the order in which documents are translated.

 3.  Enter the path and name of the directory you want to add to the publication. Use the 
Browse button, if necessary, to locate the desired directory.

Figure 15-1 shows the Styled folder for the ..\Stellent Content 
Publisher\Samples\en\Styled directory. But you can pick any directory for the purpose of 
this lesson.

 4.  In the Title text box, enter a name for the directory. 

This name can be used to create a title for your Web pages (see the Titles tab dialog in 
Globals). It will also appear on the title bar of the Properties dialog box once you exit the 
dialog box and then return to it again.

 5.  In the Include files matching the following specification only text box, enter the 
extensions for the types of files you want to translate. 

You can enter more than one extension. Separate multiple extensions with a semicolon, 
thus: *.doc;*.txt. And you can use file names to control the files you translate; for 
example, Sales*.doc would result in Site Builder translating such files as SalesQ1.doc 
and SalesQ2.doc.
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 6.  In the Map file property text box, enter any information you want to appear in the 
Directory element in the XML Map file that Site Builder generates when it translates the 
project. See “Map file” in the Help system for more information. 

 7.  In the Prefix to be added to all output file names text box, enter the prefix to apply to 
each output file in this Directory Item. See “Adding a prefix to output file names” in the 
Help system for more information.

 8.  Under Output Directories, enter the paths and names of the directories you want to use for 
the translated files. You can use different directories for output pages and graphics files, 
and you can enter a directory that doesn’t exist. (Site Builder will create the directory 
when it translates the files, assuming the directory can be created.)

 9.  Under Template, click Choose Template, to open the Choose Template dialog box. The 
Documents box in this dialog box lists all the documents currently in the selected 
directory that have the specified extension. A temporary translation of the first document 
on the list will display in the Preview window if the Auto button is checked. Pick the 
template you want to associate with the documents.

Note the default setting None under Import Styles or Patterns. (This is the default for all 
templates and should have been used when you created Corporate.tcp.) With this default, 
Site Builder assigns ranks to the top-level content of source documents, as opposed to 
importing styles or patterns from those documents. Ranks can be especially effective with 
Directory Items because multiple source documents added at different times may have 
varied and inconsistent formatting. (For more on ranks, see Lesson 9, “Handling ranks, 
styles, and patterns.”)

 10.  Click Sort to switch to that tab dialog. Under Sort Order, select Ascending. Under Sort 
By, select Document Name.

 11.  Click OK to return to the Properties dialog box, and OK again to return to the main 
window. 

The Contents pane now has a single entry for the Directory Item you have just added to 
the Marketing publication (see Figure 15-2). Only *.htm displays in the Output column (it 
will be repeated if you specify more than one file type). When Site Builder translates all 
files in this directory, it will name them after the original file names, except for the 
change in extension. The path that displays in the Source column includes all the 
extensions specified. 

Note: The extension used will be the default output extension specified in the Application 
Options dialog box.

Figure 15-2  The Contents pane for the Corporate Site publication with a Directory Item 
selected for Marketing. (The large toolbar is hidden here.) Since source documents could be 
added to the directory at any time, the Status column is always blank.
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You might care to translate the publication now and check a couple of things. If so, check the 
output directories in the Publication Properties dialog box for the root publication. Since we 
haven’t previously translated this project, you should find that for both Pages and Graphics the 
directory is C:\Documents and Settings\<username>\My Documents\Stellent\Output. 
(This is the default output directory, which is used for each project, unless you change it.)

Whichever applies to you is the default output directory for all new projects in Site Builder. For 
the purposes of this lesson, you might want to change it to C:\Program Files\Stellent Content 
Publisher\Output\Lesson 15.

Now click the View button ( ) to view the results. If you used the Styled directory in 
..\Stellent Content Publisher\Samples\en, the first output page to open will be for First 
Page.doc, the first file listed alphabetically in that directory. All the files will be linked because 
of the default navigation buttons set in the template you chose. 

You might also care to check the output in Windows Explorer. Site Builder will have created an 
output directory per your instructions in the Properties dialog box.

Set translation options available for Directory Items

Now return to Site Builder.

 1.  In the Contents pane, right-click the Directory Item and choose Properties from the 
popup menu.

The Properties tab dialog opens. This is the same as the New Directory Item Properties 
dialog box, except that the title bar reads “Styled Documents Properties” (assuming you 
gave the Directory Item the title “Styled Documents” when you first used the dialog box). 

 2.  Click Sort to open that tab dialog. 

Here, we can set translation details to control the order in which source documents are 
translated and therefore the order in which they will appear in your browser when you 
scroll through the Web publication using the Previous Page and Next Page navigation 
buttons.

 3.  In the Sort tab dialog, under Sort Order, select Ascending or Descending. The sort order is 
determined also by what you select in step 4. If you choose Document Name there, 
Ascending means that Site Builder will translate the documents in the directory 
alphabetically, from A to Z. 

 4.  Under Sort By, select the appropriate radio button for document name, document size, or 
document date and time.

 5.  Click Options to switch to that tab dialog. Under Conversion Options, select Pass 
through files matching the following specification if you want any documents in this 
Directory Item to be passed through to the output folder in their original format, retaining 
the original file name and extension. Enter the file types to pass through (such as 
*.pdf;*.avi) and select an output directory. If you are interested in this option, see “About 
pass-through conversion” in the Help system for more information. 

 6.  If you want to change the extension for all output pages, you can enter the new extension 
in the Output page extension text box. For example, you might want to use html 
instead. 

Note: This extension will be used only for the output pages generated from source 
documents in this directory, and only for new source documents added to the Directory 
Item after the change is made. 

 7.  You might care to experiment here, changing the options, retranslating, and then checking 
the order of the output Web pages in your Web publication. 
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Remember: as with other Properties dialog boxes, you can edit the properties of a Directory 
Item at any time by right-clicking the item in the Contents pane and choosing Properties from 
the popup menu.

Use the Folder Import wizard

With the Folder Import wizard, you can import a portion of your file system hierarchy directly 
into the publication hierarchy of your project. You will have to specify the same file type 
extensions for all folders imported, as well as the same template for all source documents in 
those folders. But once you import the folders, you can edit individual Directory Items for file 
types and templates.

 1.  In the Publication Hierarchy pane, select Finance, and then choose Import from the File 
menu. The Folder Import wizard opens.

 2.  In the opening screen of the wizard, enter the root folder in the text box, or click Browse 
to open the Browse for Folder dialog box to locate the root folder you want to add to the 
Finance publication. 

 3.  Locate Samples\en in the ..\Stellent Content Publisher directory and select that as your 
root folder. 

Note: Although you are adding the Samples folder, as well as all folders beneath the 
selected folder in the file system hierarchy, you won’t see the folder name once you 
import it. However, any individual files in the root folder (or placed there in future) will 
be translated by Site Builder.

 4.  Click Open and then OK to return to the Folder Import wizard, where the path to the root 
folder now appears in the Root Folder text box. See Figure 15-3.

Figure 15-3  The opening screen of the Folder Import wizard, with ..\Stellent Content 
Publisher\Samples\en already set up as the root folder.

 5.  Click Next to open the Select Import Method screen. 

Note your two options here, under Import Method. The default Import Directory Items 
means that Site Builder will treat each imported folder as a Directory Item. Site Builder 
will translate whatever source documents are in these folders at the time of translation (if 
you choose Update Versions before you translate). If you select Import Documents, Site 
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Builder will import those documents currently in the folder (according to the file formats 
specified in the Wildcards text box).

 6.  Accept the default Import Directory Items, and in the Wildcards text box type 
*.doc;*.txt (note that you separate multiple entries with a semicolon). Then click Next.

 7.  In the Conversion Options screen, select Pass through files matching the following 
specification if you want any documents in this Directory Item to be passed through to 
the output folder in their original format, retaining their original file name and extension. 
Enter the file types to be passed through (such as *.pdf;*.avi) and select an output 
directory. Then click Next. If you are interested in this option, see “About pass through 
conversion” in the Help system for more information. 

 8.  In the Choose a Template screen, select a template from the drop-down list. Then click 
Next.

 9.  The Ready to Import screen shows a summary of your decisions. To change any of the 
information, you can click Back. 

 10.  Click Finish. Site Builder will import the specified portion of your file system into the 
Finance publication in the publication hierarchy. See Figure 15-4.

Figure 15-4  The Finance publication with one of the three Directory Items imported with the 
Folder Import wizard showing in the Contents pane.

Tips

 1.  You must use the same template for all source documents in a Directory Item. But after 
you import multiple folders by using the Folder Import wizard, you can change the 
template for any individual Directory Items in the Properties dialog box for that Directory 
Item.

 2.  Likewise, you can also change the Wildcard selection at any time, as well as translation 
options.

 3.  The Folder Import wizard imports the root folder, too — even if it’s empty at the time. 
You won’t see the name of the root folder in the publication hierarchy, but Site Builder 
will create a Directory Item (click Finance in the Publication Hierarchy pane). Any 
documents added at the root level in future will be translated just like those documents in 
the subdirectories.

 4.  Yet another way to import a publication hierarchy from the file system is by creating a 
dynamic Directory Item. You make this selection on the Options tab dialog of the New 
Directory Item Properties dialog box when you first create a Directory Item. (See the next 
section.)
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Creating a dynamic Directory Item

When you add a Directory Item, you have the potentially powerful option of making the 
Directory Item dynamic. You do this by selecting the Include subdirectories option in the 
Options tab dialog of the New Directory Item Properties dialog box.

If you accept the default setting (by leaving the check box cleared), only individual source 
documents at the top level of the specified folder are added to the project. That is, you create a 
Directory Item in the usual way, as explained in the above lesson. However, if you select 
Include subdirectories, Site Builder not only imports the specified folder, but also the 
hierarchy of folders that the specified folder contains. Moreover, it automatically processes 
source documents in all the folders.

Notes

 1.  Only the parent Directory Item is visible in the Contents pane. 

 2.  Site Builder in effect creates a hidden subpublication for the subfolders of the parent 
Directory Item. The subpublication inherits the properties of the publication in which the 
dynamic Directory Item resides. 

 3.  If you create a TOC for the parent Directory Item, you are, in effect, creating a TOC for 
each subfolder—and the contents of the subfolders are promoted so that the TOC for the 
parent Directory Item summarizes the complete hierarchy of the dynamic Directory Item. 

 4.  Promotion and linking specified in the template for the TOC of the parent Directory Item 
apply to all subfolders. Likewise, any reference pages you assign to the parent Directory 
Item (as well as any files associated with the parent) are automatically inherited by the 
subfolders, too. 

 5.  Site Builder includes in translation any new subfolders added to the hierarchy in the 
future. You must update the dynamic Directory Item before you translate (the Update 
Versions dialog box opens for you to do this).

 6.  This dynamic option is not available when you add a Directory Item from Content Server.
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LESSON 16

Creating TOCs at Different Levels

As you build a publication hierarchy, navigation becomes increasingly important, especially if 
there are several levels of subpublication in the project. Adding a Table of Contents at each 
level, and linking the TOCs, is one way to help readers find their way around a complex Web 
site. 

In this lesson, you will

! Create a master TOC for the root publication

! Create a TOC for each subpublication

! Edit the master TOC for the root publication

! Edit the TOC for the subpublications

You tackled some of these tasks as you completed lesson 12, “Creating a more sophisticated 
frameset.” But it’s worth revisiting key points here.

Create a master table of contents

 1.  Open Corporate.tcp and return the project to its original form by deleting any content in 
the subpublications.

 2.  In the Publication Hierarchy pane, select Corporate Site and click Add Reference Page  

on the standard toolbar ( ) to open that dialog box. (You can also right-click the root 
publication and choose Add and then Reference Page from the popup menu.)

 3.  Under Type, select Table of Contents. In the Name text box, type Master TOC. And from 
the Template drop-down list, select Executive TOC.

 4.  Click OK to return to the main window. 

You have now created a master TOC for the publication as a whole.

Create a TOC for each subpublication

 1.  In the Publication Hierarchy pane, select Marketing and click Add Reference Page 

on the toolbar ( ) to open that dialog box.

 2.  Under Type, select Table of Contents. In the Name text box, accept the default Table of 
Contents. And from the Template drop-down list, select Analysis TOC.

 3.  Click OK to return to the main window. 

 4.  Repeat steps 1 through 3 for the other three subpublications.

Note: you have selected a different TOC template for the subpublications. As you’ll see 
when you translate, the two templates aren’t compatible, but looks don’t concern us here. 
What’s important is that different templates allow us to edit the master TOC separately 
from the TOCs used for the subpublications. 

 5.  Select Corporate Site in the Publication Hierarchy pane, and note the display of TOCs in 
the Contents pane (see Figure 16-1).
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Figure 16-1  The initial setup of a master TOC and a TOC for each subpublication.

Let’s create some content for our subpublications.

 1.  In the Contents pane, select Marketing, and click Add Document on the toolbar ( )..

 2.  Select Other Issues.doc from the ..\Stellent Content Publisher\Samples\en\Styled 
subdirectory, and click Open.

 3.  In the Choose Template dialog box, accept Academy as the template associated with the 
document, and select Styles under Import Styles or Patterns. You may want to turn off the 
Auto check box under Preview Updates, since you won’t need it for this lesson.

 4.  Click OK to return to the main window. 

The source document has nothing to do with “marketing,” but it will serve our purpose 
here.

 5.  Repeat steps 1 through 4 for the other three subpublications, adding one source document 
to each subpublication, all from ..\Stellent Content Publisher\Samples\en\Styled: Page 
Navigation.doc, Publication Hierarchy.doc, and Publishing Process.doc.

 6.  You’re about to translate the project, but before you do you might want to open the 
Properties dialog box for the root publication and change the output directories. If you 
changed these for the previous lesson, you are probably using C:\Program Files\Stellent 
Content Publisher\Output\Lesson 15. You might want to change it to ..\Lesson 16 for both 
pages and graphics. 

 7.  Accept all defaults settings in the reference pages. Click Translate on the standard 

toolbar ( ). Once the translation is complete, select Master TOC and click View 

( ).

Your master TOC should look like what you see in Figure 16-2.
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Figure 16-2  The master TOC translated with the default settings.

 8.  Click Marketing Table of Contents, the first entry in the master TOC, to jump to the 
TOC for the Marketing publication. Figure 16-3 displays what you should see in your 
Web browser.

Figure 16-3  The TOC for the Marketing subpublication, again from translating with the 
defaults accepted for the template.

As we look at the two TOCs, it’s clear that they could be improved with some quick editing. 
The master TOC possibly needs only single jumps to the other TOCs, which also could be 
simplified.

Edit the master TOC for the root publication

 1.  In the Publication Hierarchy pane, select Corporate Site.
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 2.  In the Contents pane, select Master TOC and click Element Setup  on the toolbar. 
The Elements tab dialog should appear as you see it in Figure 16-4.

Figure 16-4  The Elements tab dialog in Element Setup for the master TOC, showing the 
standard defaults for including elements in any reference page template.

Note the three elements included in the body of the master TOC: Title (System) resulted 
in “Master TOC” in the Web page (Figure 16-2), Title resulted in “Marketing Table of 
Contents” and other similar entries, and Heading 1 produced “Other Issues” and like 
headings.

(You can quickly confirm this by temporarily leaving Element Setup and opening the Edit 
Template dialog box with Master TOC still selected. As you pass your cursor slowly over 
the Preview window, tooltips will highlight the elements in use.)

 1.  To simplify the Master TOC, select Heading 1 and double-click the green check mark in 
the In Body column to turn it into a red cross. Now click OK to return to the main 
window.

 2.  With the Master TOC still selected, click Globals on the toolbar ( ), and then Titles, 
to open that tab dialog.

 3.  Under Title Contents, clear The publication component check box. Then click OK to 
return to the main window.

Depending on how you created Corporate.tcp, this may not be necessary. If you gave the 
root publication the name “Corporate Site,” then in Figure 16-2, the TOC title would have 
read “Corporate Site Master TOC.” 

 4.  In the Contents pane, right-click Master TOC and choose Properties from the popup 
menu to open the Document Properties dialog box.

 5.  In the Document Title text box, type Corporate Site. Click OK.

As an alternative to steps 3 and 4, if you had named the root publication “Corporate Site,” 
in Globals you could have cleared The document component check box, instead.
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Edit the TOCs for the subpublications

 1.  In the Contents pane, select the TOC for one of the subpublications and click Element 

Setup on the toolbar ( ). It doesn’t matter which TOC you select, because they all 
share the same template.

 2.  The Elements tab dialog should appear just the same as you saw it for the Master TOC 
(Figure 16-4), except that the title bar will have changed. 

 3.  This time, select Title and double-click the green check mark in the In Body column to 
change it to a red cross and so remove the element from the reference page. Then click 
OK to return to the main window.

 4.  In the Publication Hierarchy pane, select Corporate Site, so that all the TOCs show in the 
Contents pane. 

 5.  Select the first TOC, for Marketing.

 6.  Right-click and choose Properties from the popup menu. In the Document Properties 
dialog box, change the Document Title to Marketing.

 7.  Repeat steps 5 and 6 to change the Document Titles for the other three publications to 
Operations, Finance, and R&D, respectively.

 8.  With one of the subpublication TOCs still selected in the Contents pane, click Globals on 

the toolbar ( ). Open the Titles tab dialog. Under Title Contents, clear The 
publication component check box.

 9.  Click OK to return to the main screen.

 10.  Click Translate ( ). Then select the master TOC and click View ( ).

Figure 16-5 shows the Web page you should see. Click Marketing and you should jump to a 
Web page like the one in Figure 16-6.

Figure 16-5  The simplified master TOC, after some basic editing.

Of course, both templates could benefit from some formatting. But structure and content 
should always precede formatting. This exercise gave us an idea of some simple things we 
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might do to clean up TOCs, especially where you’re working with a publication hierarchy and 
the potential jumps between any one level in the hierarchy and the others begin to multiply.

To sum up

In this lesson you learned how easy it can be to set up reference pages for a publication. 

! If you’re creating a master TOC, it’s important to use a special template just for it, so that 
you can edit the template differently from the other TOCs in the publication.

! If you want to use the same look for all templates, you can simply create a special master 
TOC based on the one you’re using for the subpublication TOCs.

! Remember the defaults that exist in all reference page templates. Generally, you must 
promote elements from source documents and formally include them in the specific 
reference page you’re creating. But by default, a TOC always has three elements 
automatically included: Title (System), Title, and Heading 1.

! Remember, too, the default for titles in the Globals property sheet. By default, a TOC 
always has the publication and document components of the title turned on.

Figure 16-6  The simplified TOC for a subpublication. 
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LESSON 17

Promoting Elements Through Levels

Reference pages can help give your Web site a sense of structure and purpose. They can also 
guide readers quickly to the information they seek.

One key to creating useful reference pages in Site Builder is using the “promote” feature. This 
lets you promote content from the lowest point in the publication hierarchy all the way to the 
top level. With it, you can decide exactly what content goes into your reference pages. You can 
even ensure that content from all levels in a publication displays only in the master TOC, 
created for the root publication. In effect, you use “dummy” TOCs at lower levels to 
accomplish this.

In this lesson, you will 

! Create a simple publication hierarchy with TOCs

! Run a default translation

! Promote an element and remove TOCs

! Edit the template for the master TOC

Create a simple a publication hierarchy with TOCs

 1.  Start a new project in Site Builder. Use Promotion to name the root publication (both the 
publication name and the publication title) and the project file. Be sure to check the 
default output directories in the Properties dialog box, and change these, if you want.

 2.  Add two subpublications to the root publication: Navigation and Publishing.

 3.  Add two source documents to each subpublication, all from the ..\Stellent Content 
Publisher\Samples\en\Styled subdirectory. Associate the Business template with all four 
documents and select Styles under Import Styles & Patterns.

To the subpublication Navigation, add Page Navigation.doc and Other Issues.doc. To the 
subpublication Publishing, add User Interface.doc and Publishing Process.doc.

 4.  In the Publication Hierarchy pane, select the subpublication Navigation and add a Table 
of Contents. Associate the Business TOC template with the TOC. Do the same for the 
subpublication Publishing. 

 5.  Now select the root publication Promotion in the Publication Hierarchy pane, and add a 
Table of Contents. Name the TOC Master TOC and base it on the Administration TOC 
template.

 6.  Part of the structure you should now have for the publication hierarchy is shown in 
Figure 17-1. This is with the root publication selected. 

Remember: the Contents pane never shows the complete hierarchy. In Figure 17-1 it shows the 
contents of the root publication Promotion. If you select Navigation or Publishing, you will see 
the appropriate TOC for that subpublication plus its two source documents. 
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Figure 17-1  The main window with the contents of the root publication Promotion displayed in 
the Contents pane. 

Incidentally, you’ll have noticed that you associated one template with the TOC for the root 
publication (Master TOC) and another for the TOCs for the two subpublications. Once you 
create a publication hierarchy, and have TOCs at different levels, it’s generally best to use 
different templates because you will want to edit the templates for the TOCs differently. 

On the other hand, you may want all TOCs to have the same look and feel. You can achieve this 
by copying and renaming templates. There’s no need here, but you could, for example, have 
created a new template for the Master TOC based on Business TOC. In this way, you would 
still be able to assign different behavior to the Master TOC versus the other TOCs, while 
ensuring that all TOCs have the same look and feel. Remember: much of this look and feel 
actually derives from the graphics Set used, and you can always associate the same graphics 
Set with templates that have different names (and change graphics Sets at any time).

Run a default translation

Let’s run a translation of the publication to see what we get by accepting the default settings in 
the various templates.

 1.  Click Save ( ) and save the project file to the Samples folder.

 2.  Click Translate on the toolbar ( ).
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Figure 17-2  The Web page for Master TOC. 

 3.  When the translation is complete, select the Master TOC (for Promotion) and click View 

on the toolbar ( ).

What you should see in your Web browser is shown in Figure 17-2.

Let’s take stock. First, the title is actually two titles in one. As we learned in previous lessons, 
the default for the title of a TOC is the Publication component plus the Document component. 
(You can check this by selecting the Master TOC and clicking Globals on the toolbar and then 
opening the Titles tab dialog.) 

You can also see that the Master TOC has picked up two levels of information: the titles of the 
TOCs for the subpublications (again, composed according to the default settings in the Titles 
tab dialog of Globals) and the titles of the source documents (the content associated with the 
Title element in these documents).

Now click “Publishing Table of Contents” to jump to one of the two other TOCs (see 
Figure 17-3). This is similar to the Master TOC. But the entries here are for the Title and 
Heading 1 styles in the source documents.
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Figure 17-3  The TOC for one of the subpublications.

Promote an element and remove TOCs

To demonstrate how the promote feature works in Site Builder, we’re going to promote all the 
entries in the TOCs for the subpublications to the Master TOC. That is, we want be sure that 
the content associated with Heading 1 in the source documents (“Using Color,” etc., as in 
Figure 17-3) displays in the Master TOC, too.

Second, we’re going to get rid of the two TOCs for the subpublications. That is, we’re going to 
use them only for passing through information from the contents of the subpublications to the 
Master TOC. This will result in the Master TOC being like the Contents of a book, which 
summarizes all chapters and sections.

 1.  In the Contents pane, select one of the source documents in one of the subpublications. (It 
doesn’t matter which one, because the same template is associated with all four.)

 2.  Click Element Setup on the toolbar ( ).

 3.  From the Elements list in the Elements tab dialog, select Heading 1. Click Properties, 
and then click Promote to open that tab dialog.

 4.  Make sure that the Promote this element… check box is selected, and in the Promote As 
text box, change Heading 1 to Heading 2. (By default, elements are promoted under their 
own name, which is why Heading 1 was already entered in the Promote As text box.)

 5.  Click OK to return to the Elements tab. 

Heading 2 is now in the Promote As column opposite Heading 1.

 6.  Click OK again, to return to the main window. 

Now let’s edit the TOC of the subpublications to ensure we pick up, and “pass through,” the 
element just promoted from the source documents.

 1.  In the Contents pane, select the TOC of one of the subpublications, and click Element 

Setup on the toolbar ( ) once again.

 2.  Double-click opposite Heading 2 in the Promote As column. “Heading 2” will appear, to 
signify that this heading (originally Heading 1 in the source documents) has now been 
passed through.
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 3.  In the In Body column, double-click each of the three green check marks, in turn, for 
Heading 1, Title, and Title (System). You should end up with what you see in Figure 17-
4.

 4.  Click OK to return to the main window.

You have accomplished two things. First, you have promoted Heading 1 (as Heading 2) 
from the source documents to the Master TOC. (Actually, at this stage, you’ve simply 
made it available for inclusion in the Master TOC.) Second, by changing all the green 
check marks in the In Body column to red crosses, you’ve removed the TOCs for the two 
subpublications from the Web publication. Site Builder won’t create an empty output 
page.

Figure 17-4  The Elements tab dialog for the TOC template for the subpublications.

Edit the template for the Master TOC

You’re not quite done. Let’s now edit the template for the Master TOC (here’s why you always 
need to use different templates for reference pages at different levels in a publication).

 1.  Click Promotion in the Publication Hierarchy pane, and then select Master TOC in the 
Contents pane.

 2.  Click Element Setup on the toolbar ( ). Note that, in the Elements tab dialog, 
Heading 2 has been added to the Elements list (Figure 17-5).
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Figure 17-5  The Element tab dialog for the template for the master TOC of the root 
publication.

 3.  In the In Body column, double-click opposite Heading 2. You have now included 
Heading 2 in the Master TOC. 

 4.  Click OK to return to the main window, and click Translate on the toolbar ( ) (you 
can use the incremental translation command for the remainder of this lesson).

 5.  In the Contents pane, again select Master TOC and click View ( ).

The TOC you now see is not quite like the one in Figure 17-6. In fact, you have a problem. 
While the content for Heading 1 has been successfully promoted, the element itself has not 
been properly formatted for the master TOC. That’s because, in effect, we created a new 
element name (Heading 2) on the fly and never did format it.
106



Content Publisher
Figure 17-6  The final master TOC, with Heading 1 promoted from the bottom level of the 
publication and formatted.

Before we format this element, return to the Site Builder main window, select one of the TOCs 
for one of the subpublications, and click View again. You’ll receive an error message saying 
the document has no content and cannot be viewed. These two TOCs are now simply empty 
containers, used only to promote elements from the source documents up to the Master TOC. 
The TOCs still exist and can be seen in the Contents pane, and they can still be used to promote 
other elements in this fashion.

Let’s fix the problem with content associated with Heading 1 (promoted as Heading 2) not 
displaying properly in the Web browser.

 1.  In the main window, select Master TOC again and click Edit Template on the standard 

toolbar ( ). Pass your cursor over the Preview window and note the content 
associated with Heading 2.

 2.  Click Formatting, and from the Elements list, select Heading 2. In the Character tab 
dialog, under Font Size select Use this size. Accept the default Absolute Size in the first 
drop-down list, and from the second drop-down list, select the value 2.

 3.  Switch to the Paragraph tab dialog. Under Indentation, select Indent left side only by, 
and use the Up/Down control to enter the value 2.

 4.  Still in the Paragraph tab dialog, select Title (System) from the Elements list. Under 
Alignment, select Use this alignment, and choose Center from the drop-down list.

 5.  Click OK to return to the main window.

 6.  Click Translate ( ) again.

 7.  Select Master TOC and click View ( ).

This time, your Web browser should display Master TOC as you see it in Figure 17-6.
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Tips

! When creating references pages at different levels in a publication hierarchy, it’s best to 
associate different templates with those pages. This is essential if you plan uses a 
reference page at a particular level as a conduit to “pass through” elements.

! You can still use essentially the same template for all reference pages, to ensure a 
common look and feel for all reference pages. You simply create new templates (one for 
each level in the publication hierarchy) and base them on a master reference page 
template. 

! The key to passing through elements is to realize that they must not only be promoted to 
the next level up, but also included in the templates at that level. And if you want to pass 
them further up the publication hierarchy, you must continue to promote (and include) the 
elements in the appropriate template at each level.

! You can easily prevent any source document or reference page from displaying in your 
Web publication by removing its content. Simply ensure that each element in the 
Elements list has red cross opposite it in the In Body column in Element Setup.

! Though not included in a Web publication, a reference page with no content can still 
serve a useful purpose by acting as a conduit for promoted elements.

! Since Title is, by default, promoted as Heading 1, you must promote Heading 1 as 
Heading 2, and so on. As you do this, you are, in effect, creating new elements on the fly, 
and these elements will have to be formatted in the reference page template.

! If you want reference pages at every level in the publication hierarchy, as we had 
originally in this lesson, start by accepting the defaults in the TOCs you create. The top 
elements in any source document will always appear in the TOC if you do this.
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A p p e n d i x

A.THIRD PARTY LICENSES

OVERVIEW
This appendix includes a description of the Third Party Licenses for all the third party 
products included with this product.

" Apache Software License (page A-1)

" W3C® Software Notice and License (page A-2)

" Zlib License (page A-4)

" General BSD License (page A-5)

" General MIT License (page A-5)

" Unicode License (page A-6)

" Miscellaneous Attributions (page A-7)

APACHE SOFTWARE LICENSE
* Copyright 1999-2004 The Apache Software Foundation.

* Licensed under the Apache License, Version 2.0 (the "License");

* you may not use this file except in compliance with the License.

* You may obtain a copy of the License at

*      http://www.apache.org/licenses/LICENSE-2.0

* 
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Third Party Licenses
* Unless required by applicable law or agreed to in writing, software

* distributed under the License is distributed on an "AS IS" BASIS,

 * WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.

 * See the License for the specific language governing permissions and

 * limitations under the License.

W3C® SOFTWARE NOTICE AND LICENSE
* Copyright © 1994-2000 World Wide Web Consortium, 

* (Massachusetts Institute of Technology, Institut National de 

* Recherche en Informatique et en Automatique, Keio University). 

* All Rights Reserved.  http://www.w3.org/Consortium/Legal/

* 

* This W3C work (including software, documents, or other related items) is

* being provided by the copyright holders under the following license. By

* obtaining, using and/or copying this work, you (the licensee) agree that

* you have read, understood, and will comply with the following terms and

* conditions:

* 

* Permission to use, copy, modify, and distribute this software and its

* documentation, with or without modification, for any purpose and without

* fee or royalty is hereby granted, provided that you include the following

* on ALL copies of the software and documentation or portions thereof,

* including modifications, that you make:

* 

*   1. The full text of this NOTICE in a location viewable to users of the

*      redistributed or derivative work.

* 

*   2. Any pre-existing intellectual property disclaimers, notices, or terms
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*      and conditions. If none exist, a short notice of the following form

*      (hypertext is preferred, text is permitted) should be used within the

*      body of any redistributed or derivative code: "Copyright ©

*      [$date-of-software] World Wide Web Consortium, (Massachusetts

*      Institute of Technology, Institut National de Recherche en

*      Informatique et en Automatique, Keio University). All Rights

*      Reserved. http://www.w3.org/Consortium/Legal/"

* 

*   3. Notice of any changes or modifications to the W3C files, including the

*      date changes were made. (We recommend you provide URIs to the location

*      from which the code is derived.)

* 

* THIS SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS," AND COPYRIGHT HOLDERS

* MAKE NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT

* NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR

* PURPOSE OR THAT THE USE OF THE SOFTWARE OR DOCUMENTATION WILL NOT INFRINGE

* ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS.

* 

* COPYRIGHT HOLDERS WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL OR

* CONSEQUENTIAL DAMAGES ARISING OUT OF ANY USE OF THE SOFTWARE OR

* DOCUMENTATION.

* 

* The name and trademarks of copyright holders may NOT be used in advertising

* or publicity pertaining to the software without specific, written prior

* permission. Title to copyright in this software and any associated

* documentation will at all times remain with copyright holders.

*
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ZLIB LICENSE
* zlib.h -- interface of the 'zlib' general purpose compression library

  version 1.2.3, July 18th, 2005

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied

  warranty.  In no event will the authors be held liable for any damages

  arising from the use of this software.

  Permission is granted to anyone to use this software for any purpose,

  including commercial applications, and to alter it and redistribute it

  freely, subject to the following restrictions:

  1. The origin of this software must not be misrepresented; you must not

     claim that you wrote the original software. If you use this software

     in a product, an acknowledgment in the product documentation would be

     appreciated but is not required.

  2. Altered source versions must be plainly marked as such, and must not be

     misrepresented as being the original software.

  3. This notice may not be removed or altered from any source distribution.

  Jean-loup Gailly jloup@gzip.org

  Mark Adler madler@alumni.caltech.edu
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GENERAL BSD LICENSE
Copyright (c) 1998, Regents of the University of California

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, 

are permitted provided that the following conditions are met:

"Redistributions of source code must retain the above copyright notice, this 

list of conditions and the following disclaimer. 

"Redistributions in binary form must reproduce the above copyright notice, this 

list of conditions and the following disclaimer in the documentation and/or other 

materials provided with the distribution. 

"Neither the name of the <ORGANIZATION> nor the names of its contributors may be 

used to endorse or promote products derived from this software without specific 

prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY 

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. 

IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 

INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 

PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGE.

GENERAL MIT LICENSE
Copyright (c) 1998, Regents of the Massachusetts Institute of Technology

Permission is hereby granted, free of charge, to any person obtaining a copy of this 

software and associated documentation files (the "Software"), to deal in the 

Software without restriction, including without limitation the rights to use, copy, 

modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, 

and to permit persons to whom the Software is furnished to do so, subject to the 

following conditions:
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The above copyright notice and this permission notice shall be included in all 

copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 

INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 

PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT 

HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 

CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE 

OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

UNICODE LICENSE
UNICODE, INC. LICENSE AGREEMENT - DATA FILES AND SOFTWARE

Unicode Data Files include all data files under the directories 

http://www.unicode.org/Public/, http://www.unicode.org/reports/, and 

http://www.unicode.org/cldr/data/ . Unicode Software includes any source code 

published in the Unicode Standard or under the directories 

http://www.unicode.org/Public/, http://www.unicode.org/reports/, and 

http://www.unicode.org/cldr/data/.

NOTICE TO USER: Carefully read the following legal agreement. BY DOWNLOADING, 

INSTALLING, COPYING OR OTHERWISE USING UNICODE INC.'S DATA FILES ("DATA FILES"), 

AND/OR SOFTWARE ("SOFTWARE"), YOU UNEQUIVOCALLY ACCEPT, AND AGREE TO BE BOUND BY, 

ALL OF THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT AGREE, DO NOT 

DOWNLOAD, INSTALL, COPY, DISTRIBUTE OR USE THE DATA FILES OR SOFTWARE.

COPYRIGHT AND PERMISSION NOTICE

Copyright © 1991-2006 Unicode, Inc. All rights reserved. Distributed under the 

Terms of Use in http://www.unicode.org/copyright.html.

Permission is hereby granted, free of charge, to any person obtaining a copy of the 

Unicode data files and any associated documentation (the "Data Files") or Unicode 

software and any associated documentation (the "Software") to deal in the Data 

Files or Software without restriction, including without limitation the rights to 

use, copy, modify, merge, publish, distribute, and/or sell copies of the Data Files 

or Software, and to permit persons to whom the Data Files or Software are furnished 

to do so, provided that (a) the above copyright notice(s) and this permission notice 

appear with all copies of the Data Files or Software, (b) both the above copyright 

notice(s) and this permission notice appear in associated documentation, and (c) 

there is clear notice in each modified Data File or in the Software as well as in 

the documentation associated with the Data File(s) or Software that the data or 

software has been modified.
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THE DATA FILES AND SOFTWARE ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, 

EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 

FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO 

EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR 

ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES 

WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF 

CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH 

THE USE OR PERFORMANCE OF THE DATA FILES OR SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used 

in advertising or otherwise to promote the sale, use or other dealings in these Data 

Files or Software without prior written authorization of the copyright holder.

________________________________________Unicode and the Unicode logo are trademarks 

of Unicode, Inc., and may be registered in some jurisdictions. All other trademarks 

and registered trademarks mentioned herein are the property of their respective 

owners

MISCELLANEOUS ATTRIBUTIONS
Adobe, Acrobat, and the Acrobat Logo are registered trademarks of Adobe Systems 
Incorporated.

FAST Instream is a trademark of Fast Search and Transfer ASA.

HP-UX is a registered trademark of Hewlett-Packard Company.

IBM, Informix, and DB2 are registered trademarks of IBM Corporation.

Jaws PDF Library is a registered trademark of Global Graphics Software Ltd.

Kofax is a registered trademark, and Ascent and Ascent Capture are trademarks of 
Kofax Image Products.

Linux is a registered trademark of Linus Torvalds.

Mac is a registered trademark, and Safari is a trademark of Apple Computer, Inc.

Microsoft, Windows, and Internet Explorer are registered trademarks of Microsoft 
Corporation.

MrSID is property of LizardTech, Inc. It is protected by U.S. Patent No. 5,710,835. 
Foreign Patents Pending.

Oracle is a registered trademark of Oracle Corporation.

Portions Copyright © 1994-1997 LEAD Technologies, Inc. All rights reserved.

Portions Copyright © 1990-1998 Handmade Software, Inc. All rights reserved.

Portions Copyright © 1988, 1997 Aladdin Enterprises. All rights reserved.
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Portions Copyright © 1997 Soft Horizons. All rights reserved.

Portions Copyright © 1995-1999 LizardTech, Inc. All rights reserved.

Red Hat is a registered trademark of Red Hat, Inc.

Sun is a registered trademark, and Sun ONE, Solaris, iPlanet and Java are trademarks 
of Sun Microsystems, Inc.

Sybase is a registered trademark of Sybase, Inc.

UNIX is a registered trademark of The Open Group.

Verity is a registered trademark of Autonomy Corporation plc
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